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Introduction

Introduction

FelixCAD™, and the FCAD Graphic Developer’s Enginé (its companion
version for the professional application or corporate developer), are advanced
CAD systems designed specifically for 32-bit Microsoft Windows 95" and
NT" desktops. Installation of FelixCAD on the Windows platforms is
discussed near the end of this chapter.

Designed for the fast and effective solution of drawing jobs, FelixCAD offers
al the power, precision, and ease-of-use that the modern CAD user or
application developer require.

Range of capabilities

FelixCAD includes all of the functions necessary for constructing and
detailing drawings, with many unique features aimed at saving you time and
effort in your drawing tasks.

FelixCAD’s drawing commands and functions make short work of drawing
lines and polylines, circles and arcs, rectangles, regular polygons, solid
entities, 3D surface entities, and other elemém$xCAD allows you to
identify and defingarts, provides associative dimensioning, and helps you
build libraries for use in repetitive drawing tasks.

Drawing entities may be altered as desired by usingtufy commands.

Size, position, shape, and other graphic qualities may be changed. Advance
editing functions such asimming, filleting, and chamfering are available

to build sophisticated results.

Attributes of any part may be defined or edited, insuring all pieces that make
up a drawing retain intelligence for later recall or use. Once completed, parts
may be stored as a complex object increasing their usefulness in repetitive
situations.

For additional detailing, you may call dimensioning, cross-hatching, and
the insertion ofext elements.
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FelixCAD makes all of these functions available either by keyboard command
entry or easy-to-use palettes (floating tool boxes) for true point-and-click
drawing!

L ayers help you organize your work. This technique also improves drawing
management, and makes it easy to create effective, clear, and wel-detailed
drawings.

Instead of fumbling with a complex system of dividing the drawing into

different modes in order to see the results in various views, angles and
perspectives, FelixCAD allows you to open up to four drawings, with up to

four viewports per drawing. All views can are displayed simultaneously on

the screen for your benefit while you continue to work on the “active” view.
You may have as many as sixteen viewports open on the screen during the
drawing process.

At every step, you are supported by on-litep as well as a very useful and
detailed on-linél' utor that graphically illustrates the geometry behind the
commands. This tutorial allows you to call up the illustrated description of a
command, see how it works, and work an exercise if you Wisd tutorial

includes a discussion of the user coordinate system, the layer concept, and the
object snap and object selection functions.

FelixCAD has been designed as a truly open architecture system. This
facilitatesindustry compatibility, and allows you to freely exchange
information with other CAD applications, evaluation, and analysis programs.

FelixCAD allows theimport andexport of drawings in industry standard

DXF format orDWG format, transferring both graphic and non-graphic
information without destruction or loss of data. This ensures the file exchange
with a variety of CAD programs and applications.

Flexible and Adaptable

The configuration and customization commands allow many other
possibilities for the adaptation of the program. You may manage such things
as the use of colors and scripts, input and output media, and “hot key”
assignment of the function keys, just to name a few examples.

FelixCAD is very flexible with regard to configuration of the desktop. You
can choose between a standard pulldown menu, or one of your own definition.
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Menu, Palette and Dialog Box Customization

FelixCAD contains an integrated Dialog and Menu Editor. This editor may
be used to adapt menus to specific tasks, or to create brand new menu
structures. Most importantly for you, such changes do not require any
programming knowledge.

Palettes are toolboxes which allow for direct point-and-click access to commands
and functions. Thereare a number of included FeixCAD palettes designed to
make drawing tasks easy. Should you require additional functionality, the Dialog
and Menu Editor lets you create as many new palettes as you wish. These new
palettes may be topic-rdated commands and functions, or application-rdated.

Palettes may be called upon through point-and-click techniques or by hot-
keys. To insure optimum productivity, they can be fredy placed anywhere on
the program’s desktop.

If you prefer to modify the standard FelixCAD desktop, you may simply
choose to edit the included palettes.

Lisp Programming

Theintegrated FelixCAD Lisp Interpreter (FLISP) facilitates not only the
adaptation and extension of FixCAD, but opens wide the possibility of working
with other programs, utilities, routines, and libraries. The function library of the
Lisp interpreter includes functions to display dialog boxes and evaluate the user
input. Thisincludes those that are ddivered with the program as standard, and
those that you may choose to create with the Dialog and Menu Editor.

Developer’s Toolkit Manual

The FelixCAD Deveopers Toolkit (FDT) Application Programming Interface
(API) manual isincluded on-linefor the convenience of advanced developers
wishing to extend the program’s capabilities using C or C++ programming
languages.

FelixCAD includes an API which allows professional developers or advanced
users to access nearly all FelixCAD functions through the use of Dynamic
Link Libraries (DLL).

The API manual can be opened and/or printed using the included Adobe
Acrobat reader. Search the MANUALS folder for any .PDF extension files
starting with FDT.

3



Introduction

Documentation

The FelixCAD package includes a printed User’s Manual. In addition, on-line
documentation in Adobe Acrobat format is included for all FelixCAD
instructions for customization and programming. Of note are the on-line
manuals detailing Customization and Lisp Programming and the FelixCAD
Developer’s Toolkit (FDT), an advanced C/C++ language programming
interface available with FelixCAD.

Now let us present a short summary of the content of each of these manuals.

User’'s Guide

The User Manual contains a description of the general commands and
functions which represent the basis for drawing. is included both in printed
form and on-line form for your convenience.

To view the on-line user guide, use the included Addmeobat reader to

open the corresponding file (userguid.pdf) contained in the MANUALS sub-
directory. Instruction on Acrobat installation is contained near the end of this
chapter.

The first chapter covers basics on working with the program and introduces
the elements which are available.

The second chapter offers a detailed description of drawing aids. These are
functions for precision drawing, the object snap functions, and other precision
drawing aids. The use of different coordinate systems is explained in this
chapter as well.

The third chapter explains the techniques used to view the drawings, with
detailed explanations of the use of the viewports, how to achieve good results
from using FelixCAD’s capability to see many views at the same time, and
the use of the multiple-drawing viewing capability. The World and User
Coordinate Systems are also discussed.

The remaining chapters explain working with layers, the functions involving
drawing, working on, and detailing (dimensioning, crosshatching) objects, the
definition and insertion of parts and attributes, working with text objects, and
all other topics that pertain to helping you do a fast and easy job of drawing
and designing witlrelixCAD.
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Finally, importing and exporting functions, and outputting the drawings on a
plotter or a printer are explained.

Programmer’s Guide

The Programmer’s Guide will appeal to usersinterested in further adjusting,
individualizing, customizing and programming FelixCAD and its functions to
specific application needs.

To view the on-line programmer’s guide, use the included Adobe Acrobat
reader to open the file PGUIDE.PDF, contained in the MANUALS sub-
directory.

Chapters 1 through 3 contain a number of suggestions for possible
arrangement of the user interface, working with the alias command, macros,
and function key assignments, as well as a guide to the directory structure of
the program.

In Chapter 4 and 5 there is information describing the meaning and utilizatior
of template drawings and - understood in combination with this - the
definition of linetypes and hatch patterns.

Chapters 6 through 9 describe in detail working with the Dialog and Menu
Editor (DME), and describe the techniques used in setting up new (or editing
the standard) menus, palettes and dialog boxes.

In Chapters 10 and 11, detailed information is provided about the integrated
LISP interpreter allowing you to extend the program or comply it with special
working requirements.

In Chapter 12 there is an overview of the global and local variables used in
the program.

We look forward to your successes WidixCAD. Please don't hesitate to

call on us for assistance. Tell us your thoughts on the product and your
experiences with its use, whether you are a user or a developer. Your input
will be welcome, and we look forward to talking personally with you!
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Program Installation and Setup

FelixCAD includes an automated installation routine, which is started by
using the appropriate Windows “run” function to execute the program
SETUP.EXE contained in the root directory on the included CD.

FelixCAD offers 3 types of installation:

a)

b)

Installation in “demo” mode, whereby all program functions and
operations may be evaluated by the user. When running in demo mode,
the only exclusions from a full running system are the ability to save a
file. In addition, any printed or plotted output will contain hard coded text
entries indicating creation from a FelixCAD demo system.

Full running installation, whereby you must have an authorization
diskette available when prompted.

Update from demo mode to full running mode. As above, an authorization
disk is required to convert FelixCAD from demo mode to full running
mode.

Demonstration CD’s and authorization diskettes can be obtained from your
Authorized FelixCAD product dealer. Contact FCAD for the dealer location
nearest you.

Installation using the Windows 95/ NT 4.0 Desktop

1)
2)

3)

Insert the FelixCAD CD into the CD drive of your computer.

Under the Start function, browse the CD to select the SETUP program
contained in the root directory. The disk is an “autorun” CD, so it may
start up automatically upon insertion into your CDROM drive.

Run the SETUP program, following the on-screen prompts to complete
the installation.

Installation using the Windows NT 3.51 Desktop

1)
2)

3)

Insert the FelixCAD CD into the CD drive of your computer.

In the Program Manager, select RUN under the File menu. Browse the
CD to select the SETUP program contained in the root directory.

Run the SETUP program, following the on-screen prompts to complete
the installation.
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Installation using the Windows 3.11 Desktop

Prior to using FeixCAD under the Windows 3.11 or Windows for
Workgroups desktop, you must have the Windows 32-bit sub-system
installed. For your convenience, the FelixCAD CD includes this sub-system.

Toinstall WIN32S from the FdixCAD CD:

1) IntheProgram Manager, sdect RUN under the File menu. Browse the
CD to sdect the WIN32S SETUP.EXE program located in the
\WIN32S\DISK1 directory on the CD.

2) Runthe SETUP program, following the on-screen prompts to complete
the installation.

Once WIN32S has been successfully installed, follow steps 1-3 as described
under the Windows NT installation section.

Un-install

FelixCAD can be un-installed from your computer if desired. If using the
Windows 95 desktop, the program can be removed using the “Add/Remove”
function under the Control Panel. To remove FelixCAD using the Windows
3.11/NT desktop, run the Uninstall program. The Uninstall program will
remove the program groups and .ini files from the Windows directory.

Make sure not to delete any drawing (.FLX, .DWG, .DXF) files you may
have saved in these directories after installation.

Adobe Acrobat Installation

The FelixCAD CD includes Adobe’s on-line document reader for Windows.
To install Acrobat from the FelixCAD CD, run the ACROINST.EXE
program situated in the \ACROBAT directory of the CD. Follow the on-
screen prompts to compete the installation.

Technical Support

Please contact your local dealer or visit our homeptge//www.fcad.com
to see who your local distributor is in your country or choose tipp&t
page for hints and tips and bonus files. You can also use the FelixCAD
homepage for technical requests or reports.
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Chapter 1 The Basics of Drawing

Chapter 1

Getting Started: The Basics of Drawing

This chapter imparts a basic understanding of the program and furnishes
information regarding some of the most frequently used commands and tools.

It begins with a description of how to start the program. The chapter then
deals with the ability to create new drawings and open existing drawing files.
It also explains how to save work results, and how to terminate the work
correctly.

Y ou may choose to use the mouse or pointing device in picking from the
menu bar, tool areas or palettes.

In addition, the program can also be operated by typing commands using the
keyboard, or by using a digitizer with a tablet menu. For defining points,
distances, and angles, keyboard entry of the corresponding values gives the
advantage of greater precision. Ideally, a combination of mouse and keyboard
command access optimizes your productivity.

The chapter contains explanations of command selection, coordinate input
and other statements, whether by keyboard, mouse or digitizer. We advise the
novice user to read this part carefully and to practice the described
procedures. The program provides alternatives for many inputs and selections
during drawing construction. The variant that you choose will depend on your
own personal style.

In this chapter there is a comprehensive description of the user interface and
its dements and components. There are instructions to control the graphical
interface and the individual arrangement of its dements.
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General Remarks

FelixCAD runs on a Microsoft Windows desktop. All essential program steps
function, therefore, according to Windows protocols. Thisis true for pull-
down menus, tool boxes, dialog boxes, edit boxes, scrall bars, etc. The
desktop provides a series of standard € ements whose function and mode
match the corresponding €ements of the Windows desktop. For example,
there are buttons for opening new or existing drawing files, to save or print
drawings, aswell as for changing window arrangements.

Working with the program requires at least a minimum of Microsoft
Windows knowledge. The use of standard control e ements will not be
explained in detail in this manual. In case of doubt, please consult your
Windows manual, Windows Help, or other literature on the subject of
Windows.

T31FCAD32 1.1 Windows [_[5]x]
File Edit Draw Modifp Detal Part Options Wiew Window 7

D = e iﬁig ;I T [== 3. Farts
From Point: | EI m Eﬁg %

e ] ol Continuous Segments Append ‘Eﬁ %
[E3 C:\FCAD 32\NONAME_0.FLX 1 0 1 [=] 3

[~ Ortha
FSnap
v Grid oLl L L oLl

CLIMES | | .. .. S T

Solid Line e

- Ll Ll

@
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A SR ST

i

s 25500 [126.00 I0.00
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Starting the Program

Opening

A detailed description of the installation is contained in the preceding chapter
of this manual.

During the installation of the software the Windows Program Manager will
add a special FdixCAD program group, and will placeit in a special window.
This window will contain a program symbol for the application, a program
symbol for the dialog and menu editor and possibly, depending on the your
application, other symbols pertaining to that application.

The program should be started by double-clicking the application symbol or
by sdecting the symbol and pressing ENTER.

and Saving Drawings

In this chapter, the commands for opening a drawing, for saving the work
results, and for finishing a work session will be described.

The following commands should be understood:

New...
Open...
Close

Save

Save As...
Save All
Delete Files...
Exit

These commands are located in the pull-down menu File. Thereare also
symbals in the function bar for the most used commands of this menu.

The commands for printing or plotting, which are also found in the File menu,
will be explained in another chapter.

By default, the program saves drawings as files with the file extension .fIx.

11
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Each file contains a drawing and, if necessary, up to four views of that
drawing. Each drawing as well as each view of a drawing will be displayed in
a separate window. All view windows of a drawing carry in thetitle bar the
same filename. They differ from each other in the continuous numbering (O -
3), which is separated from the filename by a vertical line. Thisis discussed
later in this chapter.

Further in this manual, the term drawing may be used as a synonym with the
termfile. When the manual mentions “opening or closing a drawing”, it refers
to opening or closing of the corresponding file.

Also, the following paragraphs of this chapter explain the procedures used to
save the work. Moreover, the differences between the commands SAVE,
SAVEAS and SAVEALL are mentioned and explained.

To avoid unforeseen loss of data we strongly recommend periodically saving
drawings while working on them. For this purpose use the funatibo-

Save which can be activated in the configuration dialog box (see
Programmer’s Guide, Chapter 1).

Local variables will be saved along with the drawing and the enclosed
drawing entities current at the time the automatic save occurs. Such settings
as the current coordinate system, the dimensioning mode and other
adjustments will remain at your disposal.
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New Drawing

A new file has to be opened in order to create a new drawing. The command
New... in the File menu is used for this purpose. Alternatively, the command
to create a new file can called by clicking the New button on the function bar
or by typing NEW at the command line.

Thefollowing dialog box will be displayed:

New File EE
Save in: |El Sample j gl IE :

Hedge. Tiemplate Drawingl
Fiock.flx

Stump.flx

Subflx
Survey.fls

Zebral fix

[ Load Template

File narne: ITrees.fI:-t

Save as lype: IDrawing [%.f1=) j Cancel

Pl

Help

The program proposes to name the new drawing noname_n.fIx. You may
now specify afile name your choice. To determine the certain storage location
of thefile sdect a drive and directory in the dialog box.

I thefile name and the storage location are correct, confirm the settings. An
new drawing window to create a new drawing file will then be opened.

If adrawing file already exists with the same name, the program will warn
you and require a confirmation to replace the existing file.

13
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Using Template Drawings

A template drawing may be determined when starting a new drawing. A
template drawing is a model which can be used as basis for afinal drawing or
for the establishment of a drawing environment.

A template drawing offers the advantage of applying settings of an already
existing drawing to a series of new drawings. The setting of such parameters
as the drawing boundaries, snap raster, dimensioning settings, pre-defined
layers, views, etc. do not have to be repeated. Automatically, the parameter
settings of so-called local variables are loaded and set with the template
drawing. Variables that are loaded with a template drawing and variables that
will have to be specified with each drawing are described in the
Programmer’s Guide.

To start a new drawing based on a specific template drawing, activate the
check box L oad Template in the dialog box New File and then double-click
on the button Template Drawing.

The dialog box Template Drawing will be displayed. Select the drawing to be
to used as a template drawing and confirm the choice.

Template Drawing K E3
= ; V| Previ
L Ia Blocks j gI E 2 i Ereview
Peatchbafix sdcb.flx TableT flx Valve flx
Poleanau.flx sdmh. flx T ableZ flx WtablD. flx
Poulvert flx Shi_blok.flx T ablhead fix Wtabl e
Pliftsta flx ssmhflx T agline. flx
Prnanhole. flx Station.flx
Paint flx Station2. flx

Santag flx T bl flx

File name: | Title-2.flx

Files of type: | Drawing [~1ls)
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Find... (Find a File)

If you do not know the exact name or the storing location of a drawing or file,
you can look for it by using the Find option. The dialog box Find File will be
opened. Select the drives to be checked. Enter the file name of the drawing to
be found. Y ou may use the known wild cards * (for any group of characters)

and ? (for any single character).

After the entries are confirmed the program will search for corresponding file

names in the indicated drives.

All files matching the search criteria will belisted in aresult list. The size,
construction date and time as well as the location will also be indicated. You
can now select the desired file from this list and confirm your choice.

Find File

Searchpath:
ch

£ e

[Z] apabib
I:'l apastart
(L] apstud
[ od_felix
[ dev

Dirive:

ﬂ Cancel |

| =D e disk2 voll
Fird: * Fa

o hapastathaPalAPADDT FLX ﬂ
o hapastathaPA\APADDZ FLA

o hapastath P A PADDZ FLA

o hapastath A PANAPADDS FLX

o hapastath AP \APADDD FLA

o hapastath A Pa\APABIBMBUE 2 001 FL=

o hapastathaPa\APABIBAVBLUE 2 002 FL=
ohapasztarthaPaiAaPaBIBAVBILEZ 003 FL=

o hapastarthaParaPABIBVBLUE 2004 FL= ;I
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Open an Existing Drawing

16

The command Open... in the menu File, is used to open an existing drawing
file. This command can also be activated by typing the command OPEN or by
clicking the standard symbol Open in the function bar. After the entering the
command, you will seethe Open File dialog, and you may typein or sdect a
drive, directory, file name, and file type.

Open

Lok in: |El Sample j gl O

Hedge. fl+
Rock flx
Stump.fle
Sub.fl
Survey.fln
Trees.flx
s8] Zebran o

v Breview

File name: ISuwe_l,l.FI:-c Open

(= QTR | Drawing [ fiz) Cancel

[ Open as 1ead-anly Help

i

FeixCAD can directly open .FLX files, .DWG files saved in R2.5-R14
format, or .DXF files.

Read-Only Mode

Y ou may activate the Read-Only option in the Open File dialog box. The
Read-Only mode allows the file to be opened in order to be read, but it may
not be modified under its original name. Thisis a protective mechanism
against inadvertently modifying or changing the file. After opening in Read-
Only mode, thefile can be modified in any way, but the modifications will not
be saved. If you should try to save a Read-Only file, the program will send an
error message and ask, at the sametime, if the file should be saved under
another name. If the changes are to be saved, then you should answer Yes and
type another file name in the File Open dialog box.

[CpenDravivg N | V05

When opening a drawing, the above will appear in the bottom left corner of
the program window to show the progress of the load. The blue bar moves
from left to right as the drawing loads and disappears when completed.
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Closing a Drawing

Closing a drawing indicates that the work on this drawing is finished. The
program remains open.

To terminate working on the current drawing, select the command Closein
the File menu or press the keys CTRL+F4. This command can also be
keyboarded by typing CLOSE.

It is also possible to close the drawing window, as in all Windows programs,
by double-clicking on the system menu area (Ieft top corner for Win NT/3.11,
right top for Win 95/ NT 4.0). This activates the command WCLOSE and
the drawing window(s) will be closed.

If a drawing has been changed before closing there will be a prompt asking
whether the file should be saved. Thisisto prevent unintended loss of work.

If you decide to save the drawing, the program will automatically switch to
the standard routine to save the drawing under a new name. Drawings may be
directly saved to .FLX format, DWG format (R12, R13 or R14), or DXF
format.

Save the Current Drawing

The command SAVE causes the drawings in the active window to be saved.

At this time the file will be saved under its present name. Thefileis saved in
the FLX drawing format and to the same storage drive and directory as was
specified at the time of opening.

Automatically, a copy with the extension .bak is created to save the work
done.

The command to save can also be invoked from the menu File or by clicking
on the Save button in the toolbar.
Save All Current Drawings

The command SAVEALL from the menu File command will not only the
save the drawing in the current document window but also all other open
drawings.

17
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Save As...

The command SAVEAS from the menu File also saves the current drawing,
like the above mentioned command SAVE.

However, it allows you to save the drawing under a different name, or in a

different area.

The command SAVEAS will require that you answer these questions, all

contained in the dialog box:

* Filename

» Fileformat

* Drive

» Directory/Sub-directories

This command will then save the work done under the new filename, or in the

new storage area. Drawings may be directly saved to FLX format, DWG

format (R12, R13 or R14), or DXF format.

Save Az

Save in: I £ Sample

Hedge. fl
Rack. flx
Sturnp. flx
Sub.flx
Survep.flx
Trees.flx
Zebral. flx

File narne; Survesy flx

VR EI R P 30 Dirawing [7 i)

Save
Cancel

Help

Pl
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Deleting Files

The program contains a function for deleting files. It allows you to remove the
so-called lock-files. The Delete function is called from the menu File, or
entered by typing the command DELFLK.

L ock-Files are security files which are created by the program when a
drawing file is opened. They carry the same name as the original file and can
be identified by the extension .flk. Lock-Files will be deleted automatically, if
the drawing files are closed in the normal manner.

This procedure avoids two or more users working on one drawing at the same
time when in a networking environment.

If the program is unexpectedly interrupted and the files have not been closed
before the interruption, the same situation will occur. If you try to re-open a
file after an interruption you will get the message File locked.

In order to re-gain access to the drawing, the corresponding L ock-Files must
first be deleted.

In order to ddetethesefiles, first enter the command. Next, you must perform the
standard steps for the sdection of files (Smilar to the steps in opening files). The
programwill offer the extension .flk as the desired file formet.

Ddete the offending lock-file, and the drawing file can again be opened.

Exit: Terminating the Program

It is very important to end every working session correctly by using the EXIT
command in any of these fashions:

e Sdect Exit in the pull-down menu File and confirm.
* Pressthe ALT+F4 keys.
» Double-clicking on the system menu area (see Windows manual)

If there are open drawings which have not been saved, the programwill send a
safety question. If you confirm, the dialog Save File Aswill be called.

After saving the drawings the working session with the program will be
finished.
19
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The Program’s User Interface

After starting the program you will see the FelixCAD desktop. It contains a
series of standard eements. These are the menu bar, the function bar, the
vertical symbol bar, and the status bar.

20

In addition, the desktop may also contain several palettes and a cursor menu
when applicable.

Y ou can find comprehensive references to the configuration and the individual
customization of the desktop as well as the method of saving the settings in
Chapter 2 of the Programmer’s Guide.

The following picture shows the standard variant of the desktop.
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Menu Bar and Pull-Down Menus

The separate pull-down menus are arranged in the menu bar. Each pull-down
menu contains groups of thematically-related commands. The content of the
Menu Bar varies depending on the loaded menu file. Different menu files may
be loaded, adapting the menu bar to the specific necessities of the user.

Menu files can be identified by the extension .mnu. The program contains a
standard menu file located in the sub-directory APPLIC.

The program offers you the opportunity to load different menu files. These
files can be individualized menu files, which have been created and adapted
by help of the Dialog and Menu Editor (explanation in the Programmer’s
Guide), or any of a number of standard menu files supplied with the program.

The menu file can be changed by using the Desktop/T ool Manager from the
File menu or by typing the command MENU into the command line or the
text window. For further information see the paragraph Desktop and T ool
Manager in Chapter 11 of this manual.

To open the pull-down menus you should click on the desired menu name or
press the AL T-key and the hotkey of the name. The menu will open and you
may select a command which is available.

e Dimmed, or grayed-out commands are not available in the particular
working situation and can therefore not be seected. The command Save,
for example, can not be executed if no drawings have been created or
opened.

e Threepoints(...) behind the command - for instance, Open... - show that
no further requests will be displayed at the command line and all command
parameters are set in a dialog box.

e Anarrow (triangle) behind a command indicates that a cascading menu
will be opened and a variant of this command must be selected.

21
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The Toolbar

Thetoolbar has its position directly underneath the menu bar. It is subdivided
in several areas and contains two groups of symbols, the command line area
and the option bar.

The symbols represent often-used commands. Their arrangement in the
Function Bar permits these commands to be executed without opening a
menu. Simply clicking on the symbol with the mouse will execute the
function.

In the single symboal groups the corresponding commands are arranged by
subject. This explanation treats only the meaning of the individual symboals.
Y ou will find detailed explanations of the commands and their use in the
following chapters of the manual.

System Buttons

Thefirst group of six buttons are located on the left side of the function bar.
These are commands from the menu File which refer mainly to the opening,
saving and output of drawings and to the configuration of the desktaop.

Open drawing

New drawing Save drawing

Loading menus

Printing/plotting

Configuration

The functions New drawing, Open drawing and Save drawing have already
been explained at the previous paragraphs. Printing/plotting drawings refers
to the output, and will be explained in later in this manual. Explanations of
the Configuration of the desktop, as well as menu customization details are
found in the Programmer’s Manual.

Benesath this first symbol group are three additional symbols, which pertain to
execution of commands.

Ko

22
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These are (from the | &ft):

» Cancd the execution of the command (ESC);
e Withdraw the last work step (Undo);
* Restore or nullify the withdrawing of the last work step (Redo).

Another group of four symbolsis arranged next to the command line. These
symbols are for the display of the desktop and the arrangement of the
drawings, and are standard Windows functions.

»  Switch between Command Line and Text Window;
o Call palettes;

* Arrange drawing windows in tile format;

* Arrange drawing windows in cascade format.

Command Line and Text Window
The command line and the text window, serve as communication between the

program and the user. Inits default condition, the program uses a command
line situated directly underneath the menu bar that looks like this:

I;._|:| File Edit Draw Modify Detal Pat Options  Yiew ‘Window 2 _|5|1|
D =} Q Second corner: ;I T.'
= CIRCLE
E@E Center point: j E
| ] Center | 3P | 2P | Radius | Diameter | Tangent |

The button T on theright of the Text Window will allow you to switch
between this mode of display and a bigger text window, placed fredy on the
Windows desktop.

The default command lineis fixed in its position on the desktop. It is possible,
depending on the chosen script type, to change this. With the help of the scrall
bar on theright side of the Text Window, or with the keys PageUp or
PageDown the registrations can be "rolled" up and down.

Thetext window can be arranged independently on the video screen, and the
size of the screen can be adapted to specific demands. The procedure for this
is described in the Windows manual. There are no differences between these
two alternative forms of input fied.

23
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Thisfidd allows you to:

»  Specify points and values, select objects, and confirm inputs;

» Display the sdlection or input steps by the user (for example, 4 selected);

» Receive messages, indications or warnings from preceding steps user (for
example, Command not found).

All inputs made by you (commands, functions, options, selection sets,
coordinate inputs etc.) will show in the text window, so that they may be
verified before they are confirmed.

At the same time the command line or the text window is fulfilling a recording
function, you can read or reconstruct program steps of the working session
including inputs made.

Again, with the help of the scroll bars on the right side of the text window or
with the keys PageUp or PageDown the inputs can be scrolled. When
performing this function, the text window has the advantage of greater clarity.

The command lineis not to be used for large output lists, as presented
especially by the Info commands. If such functions are implemented, dialog
boxes are used.

For example, dialog boxes are used when:

« displaying or setting current adjustment variables;

« listing the geometrical information of selected entities;

 displaying status; and

« for information about the table of the drawing data base (defined layer,
loaded line types or text styles, defined views and user coordinate
systems).

Reference:

In the following chapters of this documentation the terms command line or
command line area and the term text window will be used as a synonym. If
there are any differences in the function of these terms the correct term will be
used, and the difference spelled out.
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The Context Bar (Option Bar)

The context bar is a special area of the desktop located underneath the
command line. It contains context-sensitive option buttons. Using those
buttons enables you to call options when a command is performed.

After acommand has been invoked, the options currently available are
displayed in the option bar. Clicking on the desired option will select that
option.

Hotkeys may also be used, if they are assigned to the options.

The option fields will be changed to correspond with the current status of the
drawing. Doing this keeps the number of options shown manageable. If there
are no options to the command, these option fields are empty. The option fidd
may change as often as after each step in the drawing.

The Control Panel (Side Bar)

A control pand is situated on the |eft side of the screen. This side bar includes
a permanent series of command or function buttons. The symbols arranged
there can be subdivided into three groups:

| Ortho
g: W Snap
| Grid

Drawing tool symbols

Clicking the button at the left side opens the dialog box for setting or
adjusting the precision aid functions (snap, grid, orthogonal mode and running
object snap functions).

Also, in this area you can directly control the Snap and the Grid status as well
as use of the Orthogonal mode. These functions are activated by clicking on
the appropriate check box. A marker in the check box indicates an active
condition.

Explanations for the adjustment of these functions and the their usein
drawing may be found in the following chapter 2, Drawing with Precision.

25
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CLIMES
Solid Line

el

Property tool symbols

Thetop button of this symbol group allowsto set the current layer. After
selecting this function, the selection box with the layers currently existing in
this drawing will be displayed. Y ou may choose the layer in which you wish
to work.

The second button allows to set the current linetype. The normal situation it
will be the linetype defined by the current layer. After choosing this button,
you can select explicitly a running linetype in the dialog box displayed.

Beneath this button (on the l€ft) is the symbol for setting the line color
applied when creating new entities. With this button you can define aline
color that differs from the color defined for the current layer.

On theright is the button for layer contral. Clicking this symbol will open the
Layer Manager dialog box. In this dialog box you can create, change, and
rename layers as wdl as define their status, the layer color and the type of
line.

You will find detailed references to the layer concepts, and the linetype and
color propertiesin the chapter 4, Layer and Object Properties, of this
manual.

= 8=
tl T 2
|| T[T

Symbols to control the drawing views

Thethird group of symbols serves exclusively to control the drawing views.
Theindividual symbols correspond to commands of the menu View.

The four arrows represent the commands for horizontal or vertical Pan.
Clicking one of the arrow symbols will shift the drawing in that direction.

26
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The symbol at the left means Zoom Fit. Clicking this symbol will cause the
drawing to be displayed so that all of theincluded entities are shown as large
as possible on the drawing surface.

The symbol at the right means Zoom Window. After selecting this mode, you
must define the area to be “zoomed” by selecting two points representing
opposite corners of the enclosing box.

The symbol in the middle of the second row represents the con#oand
Back. This command restores the previous view.

The two symbols in the third row, left and right, contain the fun&ioom

Out andZoom In. These commands perform step-by-step increasing or
reducing of the screen display by one factor. You can define that factor in the
function display modes.

The explanation of these commands are given in chapvéeng
Drawings.

This button which resembles a windshield represents the coniReanaw

from the menWindow. This command will cause the screen display to be
reconstructed by those pixels currently in intermediate storage. Pixels which
remain on the screen from deleted or revised entities will be deleted by this
command. This is faster than a REGEN which will update the current
viewport from the drawing database, or a REGENALL which updates all
viewports. A REGEN occurs automatically when needed, such as when you
zoom or pan the view.

27
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The Status Line

The status lineis situated at the lower side of the program’s desktop. It
contains a series of information fields. Brief help text will appear in thefirst
field. This line also contains the coordinates of the current cursor position.

[Drawlinets) s [228.00 |67.00 0.0 |

Thefirst area from the left serves two functions;

*  When the cursor is moved over the symbols of the symbol bars or palettes,
a brief description of the commands and functions which will be executed
by the chosen symbal is indicated. Information on the function of a
command sdected from any of the pull-down menu items are also
displayed in this fied.

« Thisinformation field will, in addition, display the current distance and
angle between the starting point drawing function and the current cursor
position.

[1.00 = 90.00

Thisis hdpful when you are using the cursor to input the coordinates.
The next information field shows the currently used coordinate system.

* WCS = World coordinate system
e UCS = User coordinate system

The remaining three information fields specify the X-, Y- and Z-coordinates
of the current cursor position, in that order.

The Title Bar

Every drawing window has at the top a Title Bar. The name of the file will be
indicated in this Title Bar. In front of the file name are the complete
specifications of the path, with information about the drive, the directory, and
any sub-directories in which the file was saved.

If there are several views of one drawing, the separate viewport windows are
marked by continuous numbering. This labd will appear after the drawing
name and will be separated from the name by a vertical line.
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When a drawing window is maximized the described specifications will be
found in the Title Bar of the desktop. If you have opened several files
simultaneously, the specification of the file name will facilitate having an
overview of the drawings that are working at the time.

The Drawing Area

The Drawing Areais the part of the desktop in which drawing entities are
created and modified.

Up to four drawings with four viewports each can be opened simultaneously
in the Drawing Area. Each drawing and each view will be represented in its
own window. Theindividual windows can betiled, cascaded, or enlarged to
fill the Drawing Area

If more than one window is opened, only one will be the active window. The
active window may be recognized by the presence of shading in its Title Bar.
Only drawings in the active window will be working. A window is sdected as
the active window by clicking with the mouse or the digitizer on any part of
thewindow or (if thereisfull screen view) via the menu Window.

Outside of the drawing areas the cursor assumes the typical Windows
pointing shape. Within the drawing area the cursor appears as cross-hairs.

Coordinate Symbol

Normally, FelixCAD puts a coordinate symbol in the lower Ieft corner of a
drawing. This symbol indicates the position of the axes of the coordinate
system and provides orientation of the alignment of the current coordinate
system.

You can classify theindividual axes of the coordinate symbol by different

colors, which increases the clarity of this symboal. The coordinate symbol can
be faded in and out by the transparent command TICON (Toggle Icon).

29
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Calling Commands and Controlling the Sequence of
Operations

The following paragraph explains the most important steps for the control of
the sequence of operations. The sequence of operations refers to:

« Calling commands and options;
» De€fining points, distances, angles tc.;
e Sdecting objects and entities.

The program offers several options to do these tasks. These options differ in
regard to the input medium or the use of different dements of the desktop, not
in regard to the achieved results.

All of theinputs that control the program can be performed by either
keyboard or some means of cursor control. Or, these possibilities can be
combined. For instance, when drawing a line you can define the first point by
typing in the coordinates of the start point on the keyboard and by "pointing"
the second point with the cursor control. The selection of input deviceis your
own decision.

The following explanations will deal with the differences of input by
keyboard, or by cursor control device. Input by these devices will be treated
as one, and be called "pointing device'.

In the remainder of this section “keyboard input” will refer only to the input

via keyboard in the Command Line area. The control of the typical Windows
elements of the desktop will be done through the use of a pointing device. For
instance, opening the mekile by the key sequence ALT+F will be assumed
the same as clicking on the menu fiElte by pointing device and will be

referred to asSelecting the Menu”.
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Functions of the Mouse Buttons

Left mouse button

The left mouse button serves to indicate points, sdect objects, and call for
functions and commands via pull-down menus, palettes and other symbols.

Right mouse button
The right mouse button corresponds to the ENTER key. It is used to:

« Confirminput and output operations;
e Takeover preset values,
* Repeat command.

Middle mouse button (or CTRL + Left mouse button)

During the execution of a command points frequently are retrieved. Pressing
the middle mouse button during retrieval will call a sdecting window with
object snap functions. This allows easy use of the object snap functions
during the work session.

If the system only has a two-button mouse, the selecting window with the
object snap functions can be called by simultaneously pressing the CTRL-key
and the left mouse button.

Intersection

Implied |ntersection
End Paint

tid Fairt

Center Point
Huadrant
Perpendicular
Tangent

Inzertian Paint
Faint Entity

Mesxt Point an Entity
Size Snap Box...
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When no command is running and no prompts are available, the middle
button on the mouse or the CTRL-key and left button on the mouse, will
bring up an additional Cursor menu. This makes it easy to grab some of the
more popular commands without having to move your cursor.

The commands will be explained later in this manual, with more detail, in the
appropriate sections.

Select
Line
Circle

Ao
Falyline
Text
Inzert Part

bove Previousz
Copy Previous
Rotate Previous
Scale Previous
kirror Previous
Flip Previous

Edit nits Settings

Preferences

Options in Calling Commands

Keyboard

Unlike many Windows applications, FelixCAD allows you to call commands
via keyboard input. In addition to improving the working speed and
simplifying the macros this technique also allows better precision.

Most of the commands, those for the creating, modifying and detailing of
drawings, as well as the LI1SP expressions, can be called via keyboard input.
Some specific Window operations functions can be called via symbol buttons
(in thetitle bar and the function bar) or via accelerator keys (window
arrangements, help, clipboard functions). This method is familiar to most
Windows users.

To call commands via keyboard enter the command name behind the
command prompt in the Command Line area. It looks like this: >
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Y ou will then be asked to enter further inputs, which would normally be input
with the keyboard or pointing instrument.

Pull-Down Menus

Commands (and their options) can be selected using pull-down menus. The
menus and commands may be requested by key sequence (for example:
ALT+F, N for new file) or by clicking the proper option field within its menu.
For some commands, cascading menus are available. These sub-menus offer
further commands or variations of the command.

Symbol Buttons

A series of frequently used commands can be called by clicking symbol
buttons. There are two kinds of symbol buttons on the desktop:

» Permanently displayed symbols in the toolbar or the control pane (side
bar). These buttons represent mainly commands from the pull-down
menus File and View.

« Symbolsin palettes, arranged in any way, which can contain any
command for which the palette is designed.

i

A |l 72 Bl T 3| i i

Commands and functions are called from a palette by clicking on the symbol.

Transparent Commands

A series of commands and functions are at your disposal even when another
command has been called and is being executed. These commands are called
transparent commands.

They include commands and functions for:

 changing the view onto a drawing (for example, ZOOM, PAN);
 functions to arrange the drawing windows (WCASCADE, WTILE);
 controlling precision (Grid, Snap, Ortho, Object snap functions);

» switching between Command Line area and Text Window;

» loading or closing palettes;

 calling the Info functions, and

 calling the Help function.

33
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After the execution of the transparent command the program continues to
execute the original command. If transparent commands are called using the
command line, an apostrophe must be placed before the command. For
instance:

* ZOOMOUT

Otherwise transparent commands can be called as usual by clicking the
proper option in the pull-down menus or by choosing the proper symbol.

Transparent commands can not be executed if the programis requesting
input of text strings or if a command's dialog box is active to request
command parameters.

Repeating Commands

During practical experience with the program you will often need to repest a
command. To repeat the same command either by pull-down menu or
keyboard entry would be annoying and inefficient.

Y ou can repeat the last executed command by pressing the ENTER key or the
right mouse button.

For example:

> LI NE

From point: P1

To point: P2

To point: P3

To point: <hit Enter key>
> <hit Enter key>
LI NE

From point: P4

To point: P5

To point: P6

To point: C ose

Command repetition can be performed as often asis required. In several cases
only the standard variant of the corresponding command will be repeated.
Other options that were sdected will not be used automatically. However,
these options are at your disposal, and can be selected again.
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Canceling Command Execution

It is possible to interrupt the performance of a command before the command
has been completed. This can be useful if a command was activated by
accident.

To cance the execution a running command

» click the symbol ‘E‘ or
* presseSC

Thiswill interrupt the execution of the current command, and at the command
line you will seethe message »* Cancel *xx-

Withdrawing a Command (UNDO)

If you recognize that you have input an erroneous command, it is possible to
withdraw the command.

The program archives all steps made during thetask in alist called the Undo
List. That list contains aregistry of all of the working steps. The steps
registered in this list can be withdrawn by using the UNDO function
sequentially, each UNDO removing the next sequential step in the task.

Certain commands are not registered in the program’s Undo List. These are
commands and functions that control the viewport (Zoom, Pan, Window), set
the parameters, and other transparent functions. These steps can not be
withdrawn by using UNDO.

The Undo List is kept only with the current session of the program. It will not
be saved with the drawing.

Calling the Command

* Click the Undo symbol ‘E‘
e Sdect Undo from the Edit menu;
» Enter U by keyboard and confirm this input by ENTER.

Invoking this command will cause the last command made to be withdrawn
and all changes in the drawing caused by this command to be canceled.

The command can be repeated until all working steps stored in the Undo List have
been cancded. The program will then send out the message Undo list is empty.

35



Chapter 1 The Basics of Drawing

36

Restoring (REDO)

This command offers the ability to REDO an UNDO. It cancds the last
relevant UNDO operation.

The drawing stateis restored to the last state prior to issuing an UNDO or
DELETE command.

Thisis only possibleif there has been no other command executed between
the commands UNDO and REDO. REDO is used in this fashion:.

« Call the REDO command by dlicking the symbol [
» Sdect Redo from the Edit menu;
* Enter the command name REDO at the command line.

Only the last relevant working step will be restored.

Thisis also possibleif there have been other drawing or working operations
executed between the UNDO and the UNDELETE.
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Delete

During the creation of drawings, or, later, the editing, changing or detailing of
drawings it may be necessary to delete certain parts of the drawing. The
program offers the command DELETE to accomplish this operation.

Call the command

* by clicking the symbol —%- ;
* by sdecting the option Delete in the menu Edit; or
e by keyboard input DELETE in the command line area.

The command DELETE may be used for these drawing entities:

« Individual drawing entities, like lines, circles, rectangles, or for groups of
these entities;

e Parts and attributes;

e Text objects; or

» Dimensioning and crosshatching.

To ddete groups of entities, the respective group has to be converted to single
entities again by the command EXPLODE (Explode Complex Objects...)

Object Selecting and Deleting

After calling the command the request to sdect the objects to be deleted will
appear. The program offers (in the option bar) a series of methods for
selecting objects.

For a deleting operation as many objects can be sdected as you desire. When
the object sdection is complete the selected entities will be ddeted without
another confirmation, by simply pressing ENTER. You may wish to interrupt
the delete operation by pressing ESC.
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Undelete: Withdraw Deletions

38

Entities which have been deleted by mistake can be restored by the command
UNDELETE.

Call the command

* by clicking the symbol S%- ;
* by sdecting the option UNDELETE in the menu Edit; or
* by entering UNDELETE at the command line.

Thiswill cause al entities previously deeted to be are restored.

The command DELETE can be canceled by the function Undo (command U).
However, only those operations can be canceled which are stated in the
UNDOQO list (see Chapter 1, Withdrawing a Command).
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Chapter 2

Drawing with Precision

During the drawing process it is often necessary to specify or modify the
value of data. This occurs when the program needs input values for solutions.
In those cases a prompt will appear in the text window asking for the entry of
avalue. Examples of these required values are:

» Coordinates for defining points of the drawing (start and end points, center
points, insertion points, base points and target points)

« Distances

* Angles

»  Width values (for example, line width)

e Numbers

In this chapter datainput is discussed in detail.

Also, this chapter describes a series of commands and functions which serve
as drawing aids. The commands and functions that serve as drawing aids are:

e precision aids (grid, snap grid, orthogonal mode and object snap
functions);

« object snap function; and

» ddeting and undeleting of drawing objects.

Most of the commands and functions described in this chapter do not create
or modify drawing entities. Exemptions are the ddete/ undeete commands,
which act directly upon the drawing objects.

The settings (grid, snap) and functions for selecting and snapping objects do
influence the process of drawing and editing functions and can make the
drawing procedure much more precise.
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Data Input

Coordinate Input

The different coordinate types can always be entered as absolute or as relative
coordinate values.

Absolute Coor dinates use as their reference (starting) point the origin of the
current coordinate system, or, in the case of angle values, the angle to the
XY -plane of the coordinate system.

Relative Coordinates use as their starting point the last defined point.
Relative coordinates are sdected by adding a sign @ before the value.

Theinput @ 10, 10 defines a point which has a distance of 10 drawing units
in the positive X- and Y -axes from the last entered (or "trapped") point.

Coordinates are entered in the following formats:

Cartesian Coor dinates

Cartesian Coordinates define a point by its X-, Y-, and Z-values. Thesevalues
are entered separated by a comma. A point is used as a decimal sign.

If no Z-valueis entered it will be interpreted as Z=0.

Polar Coordinates

Polar Coordinates define a point by its distance from the coordinate origin
and the angle in the XY -plane (from the X-axis). The two values are
separated by the sign < (smaller than).

For example, the value input 10<60 defines a point with the distance of 10
drawing units from the origin of the coordinate system and an angle of 60
degree from the X-axis.

Spherical Coordinates

Spherical Coordinates define a point by its distance from the coordinate
origin, the anglein the XY -plane, and the angle to the XY -plane.

For instance, the value input 10<60<45 describes a point with the distance
of 10 drawing units from the origin of the coordinate system, an angle of
60 degree from the X-axis in the XY -plane, and an angle of 45 degrees
from the XY -planein direction to the Z-axis.
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e Cylindrical Coordinates

Cylindrical Coordinates define a point by its distance from the coordinate
origin, the angle in the XY -plane and its Z-value. Distance and angle are

separated by <, angle and Z-value by comma.

For example, theinput 10<60,5 defines a point with the distance of 10
drawing units from the origin of the coordinate system, an angle of 60
degree from the X-axis in the XY -plane, and a Z-value of 5 drawing units.

Thefollowing table gives an overview of theinput formats of the different
coordinate types, both for absolute as for relative coordinates.

Type of coordinate Input Example
Absolute Coordinates

Cartesian X,Y,Z 3,8,6

Polar distance<angle 7.5<45
Spherical (3D) distance<angle,Z-coordinate 7.5<45,12.2
Cylindrical (3D) distance<anglel<angle2 7.5<45<33
Relative Coordinates

Cartesian @deltaX,deltaY,deltaz @3,8,6
Polar relative distance<angle @7.5<45
Cylindrical (3D) rel. distance<anglel,Z-corrd. @7.5<45,12.2
Spherical (3D) rel. distance<anglel<angle2 @7.5<45<33
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Distances

Several commands require that distances beinput. This can be done by entering
numeric values or by pointing the distance with the mouse (or the digitizer's
pointing device) from a base point or between two points. Entering a numeric
vauefor a distance allows both whole numbers (integers) and real numbersto be
used. Theinput can be made by decimal or scientific notation, or as a fraction.

Width Values

Definition of width values by numeric input or pointing is done the same
fashion as defining distances.

Angles

Angles can also be defined by theinput of numeric values or by pointing the
two points.

Entering numeric values requires the use of the sign < before the value, for
instance, 10<45.

Angles are normally specified in degrees, counter-clockwise from the starting
point. Theangle O is therefore located at the right (in direction of the positive
X-axis) of the starting point.

The relative value of the starting and ending points of an anglewill also goin
a counter-clockwise direction.

Numbers

If a command requires the definition of a discreet number, for instance, the
number of entities for the placement of sides of a polygon, then the value
required must be a whole number value.

There are two different methods of inputting these values:

Input by keyboard

Input by keyboard has the advantage of precision. Using this method, you can
construct drawing entities with exact dimensions or with exact placement in
the coordinate system.

Values for distances, straight lines and other linear quantities are specified in
drawing units, angle values in degrees.

Coordinates are given, in sequence, as the values for the X-, Y- and Z-axes
with a comma between.
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Please note that a point is used as a decimal sign. A comma serves as dash
between the values for the single axes.

When specifying an input value for an angle the sign < (smaller than) comes
before the value.

An input sequence on the keyboard might look like this:

> LI NE

From point: 2.5,0
To point: 5.75,0
To point: 0,3.25
<hit Enter key>

Moving an object might would look like this:

Sel ect objects: Sdection
Basis point: 5,2
Target point: @,0

Pointing or Identifying
Pointing, or identifying, is taken to mean theinput of points, straight lines, angles
and other quantities by mouse or digitizer or ather cursor contral device

This form of valueinput is recommended when you must relate existing
drawing entities. For instance, the center of a circle might be defined by the
intersection of two lines. Inthis caseit is easier to indicate a point resulting
from the construction in order to define its coordinates.

The coordinates of the current cursor position will interpreted directly as a pair of
coordinates or, in some cases, as differential to the coordinates of a starting point.
Theclarity of thiskind of valueinput is guarantead by the dynamic preview. In
doing this you will get akind of preview image of the result of your action.

Using the object snap functions assures that the accuracy of the coordinate
input by pointing will be improved. The construction points like the starting
or ending points, the intersection points, the center points, the perpendicular
point etc. can be “pointed” with acceptable precision.

A summary of the available object snap functions and their use appears in
Chapter 2Drawing With Precision.
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Coordinate Filters

The use of coordinate filters are offered when point specifications are
requested. Coordinate filters allow you to relate the point value inputs to the
X-, 'Y and Z-coordinates of existing entities.

Some possible inputs that might be requested for point values are;

X, value X,y
value, y X, Y, Z
value, value, z value, vy, z
X, value, z X, Y, value

If you answer the question with the input:
x,10

you will be requested to enter the x-value separately. It is how possibleto
catch a second object or the geometrically significant point of an object by
using an object snap function. The X-value of this point will be interpreted as
input value for the original point definition (x,10).

> LINE

From point: P1

To point: x,10
X-coordi nate: end
of: P2

To point: 15,y
Y-coordi nate: cen
of: P3
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Relative coordinates to a given base point

When you are prompted to enter a point, the option from allows you to
identify a relative point from a given base point. For example, in a running
line command you see these prompts and responses:

> LI NE

From point: from

Base point: Identify, usually with in object snap function
Rel ati ve coordinates: @3, 3

To point:

The option from differs from object snap functionsin so far as it does not
expect identifying of objects (with the snap box). Rather than this the from
option servesto retrieve arelative point from a given temporary base point
which then is returned to the running command.

When specifying the base point the absolute and relative coordinate input as
well as the object snap functions can be applied as usual.

But, when you are prompted to specify the relative coordinates you should
pay attention to specify only relative coordinates at this point. In practice,
this means to make sure to use the @-prefix when entering the coordinate (the
different formats of relative coordinate input are summarized in a table above
in this chapter). Y ou can specify an absolute coordinate at the Relative
coordinate prompt. However, this will return the specified, but not areative
coordinate. Also, because in fact the input of an absolute coordinates cancels
the specification of an relative point, you should avoid to pick a point in the
drawing or to invoke an object snap option at this prompt.
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Precision and Units Settings

46

FelixCAD allows you to set the number of decimal places of accuracy usedin
dimensioning and the type of angular units used by running the SETUP
command. These settings are saved with each drawing, so can be set
differently in each drawing if desired. Here is the setup dialog box:

— Linear Units
AT IDecimal j
Decirnal Places: ||:|_|:|1 j Cancel |
Example: 2712

—Angular Units

—Angular format

Faormat: ISurve_l.JDr's nitz j
Decimal Places: ||:|_|:||:|[|-| j
Bzl N 35d2716" E

— Drientation— — Angle 0 Direction

G4 @

G| G F
9 I'E

The Linear Units can be set from zero to eight decimal places using:

e Decimal Units

e Fractional Units

e Architectural Units (Feet and Inches)

» Engineering Units (Feet and Inches)

» Scientific Units (Scientific exponential notation)
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The Angular Units can be set from zero to eight decimal places using:

e Decimal Degrees

» Degress/ Minutes/ Seconds

* Grads

* Radians

» Surveyors Quadrant Angles (N,S,E,W with deflection from North and
South)

Orientation

In addition, the system allows you to modify which direction causes the
anglesto increase. The default setting is for Counter Clockwiseincreasing
angles. You can set it to increase in a clockwise direction by sdecting the
Compass Angles (CW) radio button.

Angle Zero Direction

The system allows you to specify a different direction for Zero degrees. This
is of interest to different special disiplines. For example Surveyors normally
set zero degrees as “up” on the pa

ge. This allows for the correct display of angle and distance when drawing
lines on the screen. The display on the status bar is updated depending upc
the settings of the angle zero direction and the orientation.

Surveyor Units Entry

Because the Surveyor Units are so different form the other methods of entry
we have included a few extra examples to help show the entry method.

Type of coordinate Input Example (Surveyor Units)

Absolute Coordinates

Polar distance<angle 7.5< N34D30'45"W

Relative Coordinates

Polar relative distance<angle @7.5< N34D30'45"W
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The entry of the Angle is done with survey notation where the N stands for

North, the 34D is 34 Degrees from North, the 30* is an additional 30 Minutes
from North, the 45* is an additional 45 Seconds from North, and the W
indicates that the angle is towards the West.

When entering the N or S, the D and the E or W, be sure to enter them as all
capital letters. Small letters will not work.

There are 60 seconds in a minute, 60 minutes in a degr& @mtkgrees in a
circle. Surveyors divide this into 4 equal parts each with 90 degrees
measured from the North or South poles.

North
N15D52'25 W o
i MEIDZ20'45E
/.
\ /
\ /
MECD 3251 W - \
-~ /
. \\ /
West East
S
-
- N
s ™~
~ ™,
S55030'597wW ~
~
545050 24"
South

Above we see the four points of a compass, North, East, South and West. To
further show how the Surveyor Units work, several lines have been drawn

from the middle of the cross out in various directions. We have labeled these
lines with the correct Bearings. Note that all the letters used in the bearings
are in Capitals as required by the program for input.
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Settings

The command SETTINGS, which can be sdected from the Options menu or
by entering SETTINGS, is the main command to set the parameters and
modes of the drawing environment. There are tabs in the dialog giving access
to the following commands described at other places of the manual:

Tab Command Described ...

Object Snap PRECPAR .. in Chapter 2: Drawing with Precision
Snap / Grid PRECPAR .. in Chapter 2: Drawing with Precision
Draw Modes DRAWMODE .. in Chapter 5: Basic Drawing Elements
Construction DRAWMODE .. in Chapter 5: Basic Drawing Elements
Points

Edit EDITPAR .. in Chapter 6: Modifying Drawing Objects
Parameters

View VIEWPAR .. in Chapter 3: Viewing the Drawings
Parameters

Settings E B
Construction Paints I Wiew Parameters I Edit Parameters I
Object Snap Shap/Grid I Draw Modes
— Object Snap
[v Intersection [~ Center Point
v End Paint ™ Quadrant
™ Mid Paint ™ Insertion Paint
" Paint I~ Tangent
[~ Mest on Entity I~ Perpendicular
— Cursor
Snap Box: I Select Box: |5
[1-500 Pixel] g [1-500 Pixel]
ak. Cancel

49



Chapter 2 Drawing with Precision

Precision Parameters

The term precision aids covers functions which support you when drawing
new entities, modifying already existing objects, and doing detailing
operations (dimensioning, for instance). They help you precisdy define
specific points of a drawing.

The precision aids can be turned on or off and can used with fixed
parameters.

The precision aids include GRID SNAP, GRID DISPLAY, SNAP MODE,
ORTHOGONAL MODE, LIMMIN, LIMMAX and OBJECT SNAP
functions.

Grid Snap covers the drawing area with a raster. With snap activated, a
point definition made by picking with the cursor will select (“snap” to) the
nearest grid point.

The distances between grid points and the zero point can be chosen.

Grid Display covers the drawing area with a visible latticed point grid and
offers a visual impression of the distances, angles and other relations of the
objects with themselves.

This is only a display function to help you get oriented. The distances
between the points of the grid display can be set.

Limmin sets the lower left corner (limits) for the Grid Display area.
Limmax sets the upper right corner (limits) for the Grid Display area.

Orthogonal M ode limits the movement of the cursor so that it will only move
parallel to the axes of the current coordinate system. This makes it much
easier to design and place parallel, or “running”, lines or objects.

Object Snap functionsfacilitate finding and "catching" geometrically

significant points of already existing drawing objects. These can be end
points, intersections, center points, and so forth. The individual modes of
object snap functions can be called for any single selection operation from the
proper palette or via the cursor menu (middle mouse button) or be activated
(permanently) using the dialog bBxecision Aids.
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Control of Precision Parameters

The precision aids can be controlled by the common dialog box, which is
activated by clicking the left button of the following shown symbol in the
vertical control pand, or by the command PRECPAR.

| Ortho
g: W Snap
| Grid

With the buttons in the control panel on the left side of the screen the
functions ORTHOGONAL MODE, SNAP, and GRID DISPLAY can be
turned on and off. Selection of any of the aids with the cursor will open the
dialog box “Precision Aids”.

Individual Precision Aids can be switched on and off and their parameters ca
be defined within this box.

Precision Helps I
— Snap Grd —GndSpacing—————————————
W Gciive  widthe  [1.00 ™ oacive 10 | 2 |
Height: I'I.EIEI Factor: I'IU.UU 1.1 |
Drigine 3¢ [0.00 v [o00 0.0 | Ll il
— Object Shap — Orthagonal Made
[ Active
off
. . r— Curzor
™ Intersection [ Center Paint _
" End Paint [ Quadrant [S'IrjgﬂpDBPoi:-el] |5
[ Hid Paint [ Insetion Point
I Paint | Tangent Select Box: |5
I~ Nest on Entity [ Perpendicular (1-500 Pixel]
cacel_|

Within this box, there are input fields and control elements for the individual
settings. You may enter numeric values using these fields.

The control window allows you to switch on and off the individual functions.
You must click on proper window to accomplish this. A check mark in the
box means that the function is active.
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Snap Grid

Snap Grid covers the drawing area with an invisible grid. With snap grid
activated, the cursor can only select points which are positioned directly on
the grid. This means that starting and ending point, center, and any other
specific point which can be defined will always be exactly on a grid point.

The distance between the point of the grid as well as the position of its zero
point can be sdected. The grid will always follow the axes of the current
coordinate system.

Thegrid will not influence points defined by coordinate input. Even with snap
grid activated, you can define points not on the grid by keyboard entry.

Activate or de-activate snap grid by clicking the check box on the upper left
sideinthe area Snap Grid. A crossin the check box signals that the snap
grid is switched on.

From the dialog box, select the input fields Width and Height, and enter
values for the horizontal and vertical distances between the points of the snap
grid. Units of measurement for these values are, again, drawing units. The
value 1.0000 represents the distance of one drawing unit.

Using the palette button ( =) for the value Width enables you to choose a
vertical value equal to the horizontal value.

Snap Gnd

W dicive Wil [100
Height: 1.00

Origin: 5 IU.UD Y IU.UEI 0.0 |

Theinput fiedlds marked Origin in this box enable you to define the origin of
the snap grid on the X and the Y-axis. The desired coordinates for the origin
should always be entered.

Example: Entering the origin 1.0 (X) and 1.25 (Y), assuming the horizontal
and the vertical distance between the points of the snapping grid is one
drawing unit will enable you to pick points:

» whaose X-coordinates have the value 1 or a multiple of it; and



Chapter 2 Drawing with Precision

» whose Y -coordinates exceed the whole-numbered coordinate values by
0.25 drawing units.

Note: Changing settings for the grid will only be effective if the dialog box is
closed by pressing ENTER or by clicking the OK button.

Note: A grid rotated around a certain angle can be created with the option Z-
Direction when setting a user coordinate system if you move to the top view.

Grid Display

Sdlection of Grid will furnish a visible Cartesian Coordinate grid. This grid
offers avisual impression of the distances, angles, proportions and other
relations of the objects to themselves. This facilitates the subdivision of the
drawing area as wdl as aiding in creating and working with drawing objects
that have free measurements.

Y ou may select the distances between the points of the grid. The grid will
follow the axes of the coordinate system.

Grid Spacing

[ Active 10 | 2 |
Factor: I1EI.EIEI LI
0.1 | 05 |

Activate or de-activate the grid by clicking the check window on the upper
left in the box Grid Spacing. A cross in this check box indicates the grid
display is active.

In the input area Factor enter the value that defines the relation of the grid
points to the snap grid. Alternatively, you can specify a pre-defined value by
clicking available buttons.

Note:
Changing settings for the snap grid will only be effective if the dialog box is
closed by pressing ENTER or by clicking the OK button.

The Grid will only appear in the area specified by the commands LIMMIN and
LIMMAX. By defining the limits with these two variables you control the
amount of the drawing that will be covered by the grid, whenit isturned on.

53



Chapter 2 Drawing with Precision

Orthogonal Mode

Orthogonal Mode is a special tool to be used while drawing or modifying
entities. It creates a defined reation between a starting and an ending point.

If orthogonal modeis activated, it is only possible to indicate points which are
located on aline running paralld to one of the axes of the coordinate system.
Such alineis also called an orthogonal line.

In the standard World Coordinate System (WCS) the orthogonal lines will run
horizontally or vertically from the base point.

Note:

When using other coordinate systems the orthogonal lines may not run
horizontally or vertically, but will always run paralld to the axes of the
coordinate systemin use at thetime.

The rubberband line of the dynamic preview will clearly indicate which points
can be chosen. Moving the cursor to a paosition off of the orthogonal will
result in the next nearest point which lies on the orthogonal to be "snapped".

Note:

Orthogonal mode is effective only when picking points using the pointing
device. Input of non-orthogonal points is possible by keyboard input while the
orthogonal mode is activated.

& P2

P1
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Orthogonal mode aids in designing by allowing:

» Lines, chains and polylines to be designed along lines paralld to the axes
of the coordinate system;

» Changes of direction when drawing lines, chains or polylines to be
perpendicular to the current axes,

» Construction points for geometrical objects (such as radius, diameter,
arcs, dlipses, ending points for polylines, chains and so forth) to always
be paralld to the axes of the coordinate system.

When you are modifying objects, orthogonal mode means:

» Pointsfor scrolling, scaling, rotating and so forth will be exactly paralld
to or perpendicular to the axes of the defined base point. Objects or copies
will be scrolled, stretched and so forth either parallel or perpendicular to
the starting point.

The orthogonal mode is effective to use in drawing and modifying rectangular
aligned geometry.

Object Snap Functions

Many functions and commands require the definition of an exact position in
the drawing.

The determination of exact points can be done either by coordinate input or
by indicating points. Theinput of coordinates has the advantage of precise
placement, whereas indicating points often has an advantage in speed and
ease of handling.

A very efficient method to take advantage of both techniques is to indicate
points with precise references to a given geometry with the help of the object
snap functions.

Object snap allows geometrically significant points of existing drawing entities to
belocated. These points are then used as inputs for a new drawing step.
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Object snap functions can be activated permanently or be called for a single
operation. These techniques are described in the section titled Control of the
object snap function later in this chapter.

Mode of Operation

The object snap functions can not be called separately, but may be used only
with a command which requests the input of a point.

The operating principal when using the object snap function is always the
same:

» Call acommand or afunction which requires a point;

*  When the point is requested, answer by calling the object snap function or
a special mode of the abject snap function. The cursor then takes the form
of a selecting window. The command line area displays a message which
requests the point;

» Sdect the object with the cursor.

Which geometrically significant point is "picked" during the activity depends
on:

» thetype of the drawing entity;
* therespective object snap mode; and
 the specific point of the object which is chosen.

Object snap modes occasionally offer no practical use. For instance, you can
not define the ending point of a circle, while aline segment has no central
point.

On the other hand, it is possible that a drawing entity contains several points
for which the criteria of the object snap function correspond. A line entity or
an arc, for instance, always has two ending points.

(The aobject snap function does not differentiate in regard to the starting or
ending point of an object like the drawing functions do.)

The object snap function sdects, in those a cases, the nearest of the two or
more possible points. It determines, when selecting an object by positioning
the cursor, which of the possible points will be snapped. Y ou should always
place the cursor as near the desired point on the object as possible.
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Theillustration below shows the connection between the point selected and
the point snapped:

cursor position
and snaped point

cursor position
and snaped point

Controlling the Object Snap Functions

To locate a geometrically significant point on an entity, you can activate the
modes of the object snap function in several ways. How the mode is activated
will distinguish between the permanent activation and calling for a single
operation.

Explicit Object Snap: Permanent Activation

Using the dialog box Precision Aids, individual modes of the object snap
function can be permanently activated. Thisis also called running mode.

— Object Snap

[~ Center Paint

[ Quadiant
| ™ Insestion Paint
" Buint [ Tangent

I Mewt on Ertity I Perperdicular

Sdlect the check box for the desired mode(s). A cross in the check box
indicates that the mode is active. Clicking the button Off will de-activate all
of the running object snap modes.

If several object snap modes are to be permanently activated, you can
differentiate between the modes by the selected point of a object. For

example, if the modes End Point and Intersection are activated, then if the
point selected on the entity is nearest an end point, that will be sdlected. If it
the sdected point is nearest the intersection of entities, then the bisecting point
will be sdlected.
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Implicit Object Snap: Activating from Case to Case

For one-time activation of a mode of the abject snap function, you may
choose between several options.

Snap Palette

Y ou may use the Snap Palette to call individual modes of the object snap
function for singular use in combination with a designing or editing command.
This standard palette can be opened when needed and be placed anywhere on
the drawing area. Y ou may now select modes using the cursor. The desired
object snap modes can also be included in user-defined palettes with the help
of the Menu and Dialog Editor.

Cursor Menu

Another very effective method of calling individual object snap modes is by
activating the cursor menu using the third mouse button (the middle button of
the mouse respectively holding the CTRL key and clicking the left mouse
button). The following menu is opened. From this list you can select an
appropriate object snap function.

End Point
Iid Point
LCenter

Paint
Huadrant
Interzection
Ingertion Point
Perpendicular
Tangent

Mext Paint
Size Snap Box
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Keyboard Input

Using the keyboard to input a command abbreviation is another method of
activating the object snap function.

The object snap modes and their abbreviations are shown in this table:

Object Snap Mode Input
End point end
Mid point mid
Center point cen
Quadrant qua
Intersection int
Implied Intersection imp
Perpendicular to per
Tangent to tan
Next point on entity nxt
Insertion point ins
Point entity pnt
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The Object Snap Modes in Detail

When you are working with drawing entities there are differences between the
object snap functions and the modifying commands or the object sdection
function.

Object sdection functions treats a group of entities (for example, arectangle,
achain or a polyline), as one object, presupposing that the drawing entity was
created by the corresponding command and not by individual lines. Therefore,
defined objects will always be sdected and handled "as a whol€".

With regard to the object snap function, the mention of “entities” always
refers to separate lines. This is also true for the polygons and the 2D and 3D
faces. The edges are interpreted as “lines” and can be selected as relating
entities. In this way the object snap functions can be used for the edges of
planes as well as for segments of chains and polylines.

In the following explanations of the use of individual object snap modes this
difference will be assumed.

For simplicity and clarity, this text will refer, for instance, to Emel point of

aline and not repeatedly explain that this term may also refer to the segment
of a chain or polyline or the edge of a plane. This will be true for center
points and intersecting points of lines, as well.

End Point (end)

/]

The object snap functidand snaps to the end point of a line or of an arc.
Planes or the edges of faces are also interpreted as lines, and end points of
planes and faces can be trapped byEtieepoint mode.

cursor position cursor position
and snaped point and snaped point
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Mid point (mid)

[z

Snaps to the center of aline or an arc. Planes, or the edges of faces, are also
interpreted as lines, and may be snapped by the Mid-point mode.

cursor position cursor position
and snaped point and snaped point

Center Point (cen)
(0]

Snaps to the Center point of acircleor anarc.

cursor position cursor position

and snaped point c and snaped point
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Quadrant (qua)

[

Snaps to the nearest Quadrant of acircleor anarc. Quadrantsrefer to the
points of a circle or an arc, situated on the circumference at 0, 90, 180 and
270 degrees. These arethe intersecting points of the axes of a coordinate
system upon whose origin lies the center of the circle or the arc with the
circumference of this circle or arc. Only the next visible quadrant of an arc
can be snapped.

quadrants of cursor position
an circle and snaped point

Intersection point (ins)
X

Snaps to the Intersection points of lines, arcs and circles or any other
combination of them.

cursor position cursor position
and snaped point and snaped point

AN /

Implied Intersection (imp)

Whereas the object snap option int only returns an intersection point of
objects that have a real intersection, the object snap option imp snaps - in
addition -also to an implied (or implicit) intersection point. Theimp function
returns the point where the extension of two entities would intersect.
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Perpendicular to ... (per)
|25

This mode requires that a starting point for a function has already been sdected.
Activating the object snap mode will rdatethis point to the snapped point. For
ingtance, when a perpendicular is desired, the ending point for the perpendicular is
picked, and the object snap mode Perpendicular is chosen. Theresult will bea
perpendicular line from the ending point to the chosen entity.

starting point and
perpendicular

starting point and
perpendicular

Tangent to... (tan)
£

Similarly, this mode requires that a starting point for a function has already been
sdected. Activating the Tangent object snap mode will rdate this point to the
snapped point. For instance, when atangent to a circleis desired, the ending point
for the tangent lineis picked, and the object snap mode Tangent is chosen. The
result will be a tangent line from the ending point to the chosen entity.

starting point
and tangent

63



Chapter 2 Drawing with Precision

Next Point on Entity (nxt)
M

This mode snaps to the next situated point of an object when at least one point
of this object lies within the borders of the sdecting cursor box. This ensures
that entities which are designed or modified by use of the object snap function
share actually a point with the sdected object. If you sdect a point on the
space without using this object snap function it is possible that the selected
point is not on the desired object. The two objects would not have a common
point, or a “closure”.

b

Insertion Point of a Text or a Complex Object (ins)

Snaps to thénsertion point of a part insertion, an attribute or a text object.

Point (pnt)

Snaps to &oint which was created by the command POINT.
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Object Selection

Many commands, especially the commands for modifying and detailing of
objects, presuppose that the objects to be worked on are selected or marked.
This can be done by the function object selection.

Object sdlection will always be activated by the program when the current
operation requires selection of entities. The request for seection occurs at the
command line with this prompt:

Sel ect objects:

Simultaneously, the program displays functions which may be useful in the
current operation in the context bar (option bar).

Y ou will recognize the continuous display of the request for seecting objects
when marking entities.

All objects sdlected in subsequent operations will be added to the sdlecting set.
The sdlecting set includes the sum of all entities sdected for an operation.
Using the Add/Remove status, it is possible to change the selecting mode
between Adding Objects and Removing Objects from the current selection.

Selected entities will be shown in color. After marking all desired entities you
may finish the sdection by pressing ENTER: The program will continue with
the execution of the command.

Object Selection Modes

In order to sdlect objects you can employ several modes of OBJECT
SELECT. Two standard modes are at your disposal immediately. Other
modes are available in the option bar. The modes can be called by:

» Sdecting the proper switch;

* Inputting of the name of the object-sdecting mode;
* Inputting the abbreviation for the name of the object-sd ecting mode.
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The options as well as the command abbreviations are;

All a
WPolygon wp
CPolygon cp
Fence f
Last I
Previous p
Add ad
Remove re
Window w
Crossing c
Single si

During the sdlection of objects by these modes two proceedings can be
employed.

Window / Crossing

» Thismode, based on the Window principle, will mark all entities which lie
entirdy inside of the window. Entities which are touched by the sdlecting
frame or are situated partly outside will not be selected.

» The sdecting mode based on the principle of Crossing will mark all
entities which cross, or areintersected, or lietotally inside of the window.

After calling the object selection function using the proper command, the

option bar will offer these selecting modes:

WPolygon CPolygon Fence Last Previous Remove

Simultaneously, the cursor takes the form of alittle box. Thisindicates that
you are in object selection mode.

The standard modes Window and Cr ossing are available during the whole
sdlecting procedure and can be used in any sequence. All other modes are
active only for the sdecting step. Later on the two standard options will again
be at your disposal.
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Window (W)
A (rectangular) Window is defined by two diagonally-opposite corner points.
Position the cursor on the first corner of the Window and select that point.

Y ou must take care that no object is inside the cursor window (box) during
the sdection of thefirst corner point. Otherwise, the option Crossing will be
activeinstead of the option Window, and the object which is situated in the
cursor box will be marked.

Determine the second corner point of the Window. This will sdlect all of the
entities which are entirdly within the Window described.

window frame P2

The command line will again display the prompt Select Objects:
Continue the object sdection operation with the same or another selection
mode, or terminate it by pressing ENTER.

Crossing (C)

Crossing will select only entities whose contours touch, or “cross”, the
window frame will be chosen.

Position the cursor so that the window crosses the contour of the desired
drawing entity. Select to mark the object.

! |
! |
g
cursor frame
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An object will not be marked if the cursor is just situated on the areawhich is
included by the contours of the entity, without touching the contour itsdf. In
this case the program will activate the sdection mode Window and interpret
theinput as the first corner point of the window.

WPolygon (WP)

The mode Window Polygon functions in a manner similar to the option
“Window”. Again all drawing entities will be marked whose contours are
entirely inside of the selection window.

The difference between the two modes is in the form of the selecting window.
The modeéVNindow Polygon allows you to design an irregular window with

as many corner points as are desired. This allows a more flexible selection
than doewWindow.

Wpolygon

To useWPolygon, define, in succession, the corner points for the selecting
window. ThePreview mode (from the option bar) will offer a preview of the
emerging polygon.

The corner points for the selecting window can be defined in a clockwise or
counter-clockwise series. The program allows the polygon lines to cross or
intersect themselves and to shape "loops" (see the following picture).
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ENTER will conclude the definition of the selecting window. All objects that
lietotally inside of the window will be marked.

Wpolygon

Cpolygon (CP)
Crossing Polygon will create an irregularly formed window with as many
corner points as you like. All objects that lie inside of the selecting window or
are crossed by the window frame will be marked.

,,,,,,,,,,,,,,

,,,,,,,,,,,,,,,,,,,,,

Cpolygon

Definein succession (clockwise or counterclockwise) the corner points for the
window. The preview mode will offer a preview of the emerging polygon.

The program allows the polygon lines to cross or intersect, and to shape
"loops" (seethe following picture).

ENTER will conclude the definition of the selecting window. All objects that
lietotally inside of the window or are crossed by it will be marked.
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Fence (F)

Fence represents an effective variant of a crossing selection mode. The object
to be sdected will be not be closed or crossed by a window, but only "cut
through” by a line, or “fence”.

The line of the fence can be defined by as many points as you desire, and the
fence may intersect or cross itself.

ENTER will conclude the definition of the fence line. All objects which are
touched or crossed by the line will be marked and added to the selecting set.

Last (L)

The object selection modieast marks the last drawn entity and adds it to the
selecting set.

It does not have a memory function; that is, it is not possible to add to the
selecting set the entity created during subsequent “last” operations by
repeated calling of the option.

Note:

If the last drawn entity lies on a “frozen” layer you will receive the message in
the command line area that no entity was selected.

Previous (P)

The optionPrevious (P) restores the previous selecting set. All entities are

marked (and highlighted), which have been selected by the previous selecting
operation.

Note:

This mode has the same restrictions as the modes Last and All, in that entities
which are located on a frozen layer will not be marked, entities on a locked
layer will be marked but cannot be handled.



Chapter 2 Drawing with Precision

All (A)

All, called by the input all or the abbreviation a, marks all entities included in
the current drawing with the exception of those located on frozen layers and
adds them to the selecting set.

Remove Mode (R) / Add Mode (A)

Thelast field of the option bar contains a toggle button to switch between
adding objects to the current sdecting set and removing objects from the
selecting set.

The mode Add Objects is the default active mode, so you can select further
objects and add them to the sdecting set at any time.

Select the button Remove in the option bar to change the sdection mode to
Remove Objects. Objects already sdected and marked will be removed from
the selection set by this change.

Single Selection Mode (SI)

The option Single, which can also be called by the abbreviation SI, de-
activates all object sdection modes for the next and subsequent operations,
with the exception of the standard modes Window and Crossing.

Note:

This option is not offered in the option bar, but may be sdected by keyboard
input.
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Dynamic Preview Modes

72

Dynamic Preview modeis avisual construction aid which allows you to watch the
result of the pending operation beforeit is executed, and, if required, to make
corrections. Dynamic Preview also aids in user understanding of commands and
options, and hdps the user learn the program.

s —

Rubberband: A Marking Line

In any command that requires sdection of two or more points, a marking line
(rubberband line) follows the cursor movement. This line connects the last
sdlected point with the current cursor position.

This givesyou avisual impression of the operation and allows a better estimate of
distances and angles between the last fixed point and the following point.

The rubberband lineis useful both in drawing and in modifying objects.

Used during the drawing process it illustrates:

» theending point of the next segment of aline, chain or polyling;
» theradius or diameter of acircle

« thedistance between starting- and ending-point of an arc; or
 the next corner point of a 2D or 3D plane.

When used during modification of objects it helps show the distance and angle
from one base point to a second point, as wel as the target point for moving,
copying, scaling or other modifying steps.

Object Preview Picture

The Object Preview Picture shows in advance the contours of an object to be
designed or modified. It is possible to recognize the consequences of changing of
parameters like the radius of a circle or likeremoving or changing theangle of a

copy of the original object. This option alows you to interactively influence these

changes.
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Chapter 3
Viewing Drawings

These are the procedures described in this chapter:

» Working with drawing windows, creating new view windows or switching
view windows

* Viewing the drawings from different directions

» Enlarging and reducing (Zoom) as well as moving (Pan) the visible
drawing portion

» Creating a new drawing

» Useand creation of a coordinate system.

There are two options for viewing drawings. These options may be combined
for any one drawing:

» Changing the viewing angle while kegping the drawing portion or the
copy/scale. There are standard viewing angles. For example, the view
from the front, from the top, the view from the left side, and so forth. It is
also possible to define a 3D viewing point from which to look at the
drawing.

» Changing the drawing or the drawing portion while keeping the view
angle.

There are different ways to accomplish this, by using ether:
e Commands which change the scale of the drawing and thus also enlarge or
reduce the visible drawing portion, such as the zoom command.

« Commands which keep the scale of the drawing constant but move the
drawing portion, such as the pan command.
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View Parameters
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Various parameters may be selected to define the direction and general size
and shape of a given view. There are values for ZOOM and PAN of the view
on the screen, and sdections to be made to determine visibility of the grid and
the coordinate system.

To activate the dialog box View Parameters... choose theitem of that name
from the View menu or type the command VIEWPAR.

R |
Zoom and Pan
Ok |

Zoom In Factor: 0.50

|

Cancel
Zoom Dut Factor: 2.00

Fan Factor: 050

¥ Apply plan view to UCS setting;

v Display Coardinate Symbol

In the edit boxes Zoom In Factor and Zoom Out Factor of the dialog box,
you may choose the factor by which the drawing on the screen isto be
enlarged or reduced when using the ZOOMIN or ZOOMOUT command.

In the edit box Pan Factor you can specify the factor by which the visible
portion of the drawing is moved one of the panning commands PANUP,
PANDOWN, PANLEFT, or PANRIGHT. A pan factor of 0.5, for example,
moves the drawing portion to about half of the visible drawing areain a
certain direction.
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3D View and Drawing Viewports

The program is capable of opening as many as four drawings at the same
time. Each of these drawings can be viewed in its own window. Further, it is
possible to open as many as four viewing windows (viewports) for each
drawing so that the drawing may be seen from different angles or so that
portions of the drawing can be examined.

The different viewports of one drawing are kept in order by a running count
in the title of the window. This number appears right after the name of the
drawing and is separated from the name by a vertical line. These different
windows can be arranged in Tiles, Cascaded, or enlarged to fill the entire
drawing area. If more than one window exists, then only one window can be
the active window. The active window is identified by the color of thetitle
pand. You may pick a window to be the active window by clicking on any
part of the window with the cursor.

Opening Viewing Windows
In order to open a viewing window a drawing must have been created, or an
existing drawing must be open. If more than one drawing has been opened,
you should remember that all commands are executed in the active drawing.
Choose Open New Viewport on the Window Menu or enter WOPEN.
Before the program opens another window you will be asked to determine the
type of view in this new window. Choose a standard view from the menu, and
click on OK.

The chosen angle of view can be changed at any time. The new window will
be created in standard size and arranged in the manner proscribed with the
existing windows. (Tiled, cascaded, etc.)

Angle of View / Point of View

The direction from which an object is viewed influences the view of the
object, and may be changed in many ways inside one drawing window. Each
additional view will be portrayed in another viewing window.

Standard Views

The program uses as its standard viewing angle the top view (also called Plan
View). At this angle the xy-plane is viewed from the direction of the positive
z-axis, and the drawing or construction planeis parallel to the screen.
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Additionally, FRONT, BACK, LEFT, RIGHT, and BOTTOM are possible
standard views and may be activated through the dialog box resulting from
the sdlection of Open New Viewport... in the Window menu. Choose an
option and confirm through OK.

Hew Window E3 |

— %iew from

i
g||w||0||m
&0

[ Refer to WS
k. I Cancel

¥ Dirawing Preview

Plan view

To quickly switch to a plan view, sdect Plan View to Construction Plane on
the View Menu, or enter PLANVIEW.

Changing the current view direction

The command 3D View... from the View Menu (Command 3DVIEW )
alows you to look at a drawing from any point in space that you wish to
define. You must define the view direction as described above.
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SETVIEWDIR
This command can be used in place of the above graphical method, by typing;
> SETVI EWDI R
Viewpoint (X Y,Z): Rotation

The option Rotate allows to specify a new view direction to the drawing
based on two angles entered as real numbers:

Angl e theta (rotation angle in x-y-plane) <0.0>:
Angl e phi (rotation angle to x-y-plane) <0.0>:

The Angle Thetais specified with respect to the X axis, in the XY -plane
The Angle Phi is specified up or down from the XY plane
The command SETVIEWDIR cannot be used in paper space.

Changing Viewing Windows
Once you have several views open, there are two ways to change the “active
window:

1. Clicking on any part of the chosen window with the cursor will
activate it.

2. Open the pulldown merivindow, and find where all open drawing
windows are listed. The active window will be marked by a check in front
of its name. When a new window is opened, it is marked by a number in
front of the specific entry.

You may choose one of the listed windows as the active window by clicking
on that view, or by entering the number assigned the view.

Copying a Viewport
The commandopy Viewport on theWindow Menu (Command

QWOPEN) allows you to make a quick copy of the current viewport or a
plan view by choosing the desired option button.

Closing a Viewport

The commandlose Current Viewport on theWindow Menu (Command

WCL OSE) allows you to close the current viewport. Or you may use the
standard Windows methods of closing a window by pressing CTRL and F4 o
click on the X in the upper corner of the desireddeiv.
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Zoom
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The zoom commands change the viewing scale of the drawing, or of the
portion of the drawing chosen by the user. The absolute ratios of scale of the
entire drawing to the included objects chosen remains unchanged.

These variations on the zoom command are available

e Zoom Window
e Zoom Back

e Zoom Fit

e Zoomlin

e Zoom Out

e Zoom Scale

The zoom commands, like most other commands for view control, are
transparent commands that can be called up and executed at the sametime
another command is being executed. For example, it is possible to execute the
command ZOOMOUT while at the same time entering points when drawing
an dement. The screen plot will be enlarged by a pre-determined factor.
Remember that to call up transparent command you have to put an
apostrophe before the command (example, ZOOMWIN).

> LINE

From point: P1

To point: P2

To point: 'ZOOMOUT

To point: P3

To point:

To Call the Zoom Commands

The zoom commands can be activated either by sdection with the cursor or
by entering commands by hand. The symbols used to activate the zoom
variations are shown below.

Zoom Fit Zoom Window
Zoom Back
Zoom In Zoom Out
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To activate a zoom command, click on its symbol. The manual commands for
the activation of the different zoom variations can be found in the following

table.
Zoom-Variation Command
Zoom Window ZOOMWIN
Zoom Back ZOOMBACK
Zoom to Fit ZOOMFIT
Zoom In ZOOMIN
Zoom Out ZOOMOUT
Zoom Factor ZOOMFAC

Zoom Window

The ZOOMWIN command allows a chosen portion of a drawing to be shown
in the largest possible scale. The drawing portion is specified by a box.

| dentify opposite corner points with the cursor or enter the coordinates
manually.

> ZOOMW N
First corner: P1
Second corner: P2

Differences between the chosen window and the following depiction on the
screen can be due to the different ratios of height and width of your chosen
box and the screen.

The following picture shows the usage and result of the zoom command

e
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Zoom Back

The command ZOOMBACK ddetes thelast ZOOM command and recreates
the prior drawing portion. The deleted scaleis saved as the last used scale and
may now be called again. Using this command allows you to switch quickly
between two definite portions in order to view an object as a whole, or to see

its details more clearly. It is still possible to recreate the last scale if another
operation has been performed.

Zoom to Fit

The command ZOOMFIT allows you to show the drawing with all its
eements as large as possible on the viewing area.

e

The ZOOMIN command enlarges the view with each successive use by a
factor defined by the View Parameters...option on the View menu.

~ |
N \/

Zoom In
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Zoom Out

The function ZOOMOUT is the opposite of the zoom-in function. It reduces
the view with each successive use by a factor defined by the View
Parameters...option on the View menu.

i
\/ N

The function ZOOMFAC prompts you to enter the Zoom Factor. Numbers
less than 1 reduce the size (Zoom Out) and greater than 1 enlarge the size
(Zoom In)

Zoom Page

The function ZOOMPAGE zooms out to the page size defined for your
printer (or plotter)
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Panning
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The command PAN moves the visible portion of the drawing to theright, to
the left, upward or downwards. It is now easy to look at objects that were
previously not visible because they were off the viewing surface. In contrast
to the command ZOOM, the drawing scale does not change.

The panning commands are transparent ones which may be executed while
other commands are being executed. It is possible, for instance, to execute the
command PANDOWN (move downward) while entering points for drawing
an element.

> LI NE

From point: P1

To point: P2

To point: ' PANDOMN
To point: P3

To point:

Y ou should remember that, when moving the drawing, it appears that the
visible objects are moving in the direction of the command. The reason for
thisis that the panning commands act, as does a photographer, to move the
camera, but not using the zoom lens.
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How to call a Pan Command

The panning functions can be chosen through picking a symbol or by entering
the short commands manually. The symbols for the different PAN versions

are shown in the following picture.

pan upwards
= 0
& |§| pan to right
28

pan downwards ‘

pan to left

1

To activate a panning command, simply click on its symbol.

The manual commands for the activation of the different panning variations
can be found in the following table. Please remember that to call up
transparent commands you have to put an apostrophe before the command
(for example: 'PANLEFT).

PAN Variation Command
Portion to the left PANLEFT
Portion to the right PANRIGHT
Portion down PANDOWN
Portion up PANUP

After selecting one of these commands, the visible drawing portion will
immediately be moved in that direction. The amount of movement is
determined by a factor defined by the View Parameters...option on the View
menu.
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Saving / Retrieving Views (View Manager)

It is convenient when working with different drawing portions and view
directions to save and later to retrieve a previously used view or drawing
portion. Saving and retrieving user-defined views may be accomplished by
choosing the option View Manager ... from the View menu or by entering the

command VIEW.

Yiew: Store / Retrieve

A4LANDSCAPE
A4PORTRAIT
BOTTOMLEFT
BOTTOMRIGHT
CENTER

PAGE
TOPLEFT
TOPRIGHT

Shows

]|

— Dezcription
Width:  420.00
Height:  297.00

Angle: 0
Origin
o 000
Y. 000
2 noo

| Delete |

Cancel |

Saving the Current View

First, use the zoom and pan functions and/or the commands described
previously to set up a desired view direction, in order to save the wanted view

or portion of the drawing. Next:

* Inthedialog box Save/Retrieve View, choose the option New.

* Itispossibleto choose between the options View and Window. When
selecting the option View, the present portion will be saved as a user-
defined view. The option Window allows the sdection of a part of the
present portion and will save this part only as a user-defined view.

* Enter the name for the view to be saved in the edit box.
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During the drafting and construction process, named views can be applied
especially in two other situations:

e Printing: Initially the PRINT command requests to specify an area of the
drawing to be printed. The VIEW command allows you to predefine a
region of the drawing which then can bereferred to in the PRINT
command.

» PaperSpace: When calling the command VIEW in layout mode outside
the command VIEWPORT, you can create named views within paper
space (for example to zoom fast to portions of the drawing sheet).

Retrieve a Named View

A previously saved view can be retrieved through the same function, and can
then become the present view.

Follow these steps:

* Inthedialog box Save/Retrieve View choose one of the saved views from
thelist box.

» Click onto the button Show. The saved view will then become the present
view.

Delete a Defined View
Views that are no longer needed can be deleted as follows:

» Sdect one of the names of defined views in the list box of the
Save/Retrieve View dialog box.

» Click onto the Delete button. The named view will be removed from the
list immediately.
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User Coordinate Systems
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The user coordinate system can be fredy defined by the user, having the world
coordinate system as a basis. Thefollowing changes can be madein auser
coordinate system:

The origin can be moved to any point in theworld coordinate system.

The user coordinate system can be angled or turned around one or moreaxisin
reation to the world coordinate system.

Using the user coordinate system, for example, it is possibleto change the location
of the drawing planein such away that it always lies parald to the objects that
areto be drawn, making the construction of 3-dimensional objects much easier.

The coordinate system of this program allows you to determine every single point
of adrawing surface or a drawing object unambiguoudly through coordinates.
These coordinates originate in the coordinate system. The program uses a
Cartesian coordinate system consisting of three coordinate axis, of which every
pair is arranged orthogonally and which cross at the origin. All axis havethe same
measurements.

To determine the coordinates of a point, the distances of this point to the x- and y-
axis, ina 3-D system also from the z-axis, are measured.

The program differentiates the coordinate system between a world coordinate
system (WCS) and the user coordinate system (UCS).

<&

World Coordinate System

Theworld coordinate system is a permanently installed Cartesian coordinate
system that is used as a standard for all drawings. The x-axis measures the
horizontal distance, the y-axis the vertical distance from the origin. The z-axis
is orthogonal to the x- and y-plane and measures the distance of a point to this
plane. Theworld coordinate system cannot be changed by the user.
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UCS Command

It is possible to create as many user coordinate systems for one drawing as
wanted. The user coordinate system will be saved along with the drawing and
can be used again when opening the drawing later on.

Active coordinate system

From all the user coordinate systems in one drawing only one or the world
coordinate system can be the active coordinate system, that means with its
parameters active.

Choosing a coordinate system as active is done in a dialog window. Using the
same dialog window it is possible to rename, create or delete already existing
user coordinate systems.

Create new user coordinate system

User coordinate systems are always created in two steps. First the parameters
of the user coordinate system (place of the origin and direction of the
coordinate axis) are determined, second follows the saving under a specific
name. Thusit is possible to use the user coordinate system as an active
coordinate system again, without having to determine the parameters again.

To create a user coordinate system enter the command UCS. The prompt
UCS origin <0,0,0> appears. Enter the coordinates of the origin of the user
coordinate system, or press Enter to use 0,0,0.

After calling upon the command UCS, the following options for interactively
determining the place of the origin of the user coordinate system and the
direction of its axis are presented.

Control World Z-direction 3point View Rotation

The option control calls up a dialog window, that can be used to create or
choose a new active coordinate system, or to rename or delete already existing
user coordinate systems. How to use this dialog window will be shown later
on in connection to the saving of the parameters of a user coordinate system.

87



Chapter 3 Viewing Drawings

88

The option world chooses the world coordinate system to be the active
coordinate system. This allows to go back to the world coordinate system
quickly without having to open the dialog window of the command control.

Z-Direction

The option z-direction changes the parameters of the coordinate system in the
following two steps:

1. Theoriginis determined through entering the new coordinates in the
format of x,y,z or through choosing a point .

2. Thedirection of the axis of the coordinate system can be determined
through fixing the z-axis..

To do that, choose a point through which the positive z-axis, starting from the
(perhaps newly defined) origin, should go. The x- and y-axis will not be
turned and remain the same. The xy-plane will now be lifted to correspond
orthogonally to the z-axis.

UCS origin <0,0,0>: Z-axi s
UCS origin <0, 0, 0>: Enter
Poi nt on the positive z-axis:Pl

3Point

The option 3point makes it easy to adjust a coordinate system to a drawn
object in space. Thisis advantageous for constructing € ements, where the
drawing planeis neither paralle to the viewing plane nor to the axis of the
presently active coordinate system.

It is easiest to adjust a user coordinate system with the 3point option when the
points that are to be defined are seected with the cursor using the object
catch-function. This way the coordinate system is easily adjusted to the
specific working situation.

1. Choose the origin first through entering the coordinates in the format x,y,z
or through pointing to it.

2. After that, choose a point, through coordinate entry or through pointing to
it, through which the positive x-axis should run. This way the axis is
unambiguously determined.

3. Theplace or direction of the other axis can be determined through the
fixation of a point in the positive area of the xy-plane. This point does not
necessarily haveto lie on the y-axis.
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For practical reasons you should locate the necessary points so, that they are
oriented at the plane of the drawing object at which the user coordinate
system should be adjusted. For example, choose the corner points of this
plane with the object catch option. The chosen plane then becomes the
drawing plane. All dements drawn after that will be drawn according to this
plane.

UCS Oigin <0,0,0>: 3Point

UCS Oigin <0,0,0> P1

Poi nt on the positive x-axis: P2
Poi nt on the positive xy-plane: P3

View
This option adjusts the user coordinate system parallel to the active viewing

plane, the screen Through this the viewing plane and the drawing plane are
brought into harmony.

To call up this option, click onto its operation field. No further points will be
asked before adjusting the user coordinate system. The x-axis of the
coordinate system now lies paralld to the actual viewing plane horizontally,
they-axisis oriented vertically and the z-axis is orthogonal to that.

Rotation

Through the option rotate it is possible to rotate the active coordinate system
around one axis. The angle of rotation and the direction of the rotation can be
chosen randomly

To call up the option rotation, please click onto its field among the options.

Wit one call-up it is possible to rotate the coordinate system around one axis
only. If you want to rotate the coordinate system around 2 or 3 axis, please
repeat the following steps for each axis.

1. First determine the axis around which the coordinate system should be
rotated. Either enter its character or click onto its option fidd (X,Y,2),
which will appear after the activation of the rotate option.

2. Now determine the direction and angle of therotation. This is done by
entering or pointing an angle.
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Theangle of the rotation can be determined either by entering it manually or
by the pointing of 2 points. The orientation point for the angle of the rotation
is always the positive x-axis of the active coordinate system.

Entering a positive value for the angle of rotation results in a rotation to the
left, a negative value (for example -30) results in a rotation to the right.

USER COORDI NATE SYSTEM origin <0,0,0>. Rotate
Rot ate around x-, y-, or z-axis: Z
Rotation around Z-Axis <0>: 30

Control the user coordinate system

Of courseit would not be very user friendly and not very effective for the
precision of your work, if you had to make the above adjustments every time.
Therefore FCAD offers a comfortable possibility to save and organize pre-
defined user coordinate systems. The parameters of the active coordinate
system are gathered in a user coordinate system and saved along with the
drawing. When saving, the user coordinate system gets a definite name. Once
auser coordinate system is saved, it can always be called up again to be the
active coordinate system. They can also be renamed or deleted.

The necessary steps to gather and organize user coordinate systems are
executed through a dialog window. To open this window please choose the
option user coordinate system-manager, which is found when using the
standard menu in the pull-down menu view

Also it is possible to open a dialog window by entering the command UCS
and choosing the option Contral.

Create a new user coordinate system
The creation of a user coordinate system is donein two steps

1. Arrange the coordinate system with the previously described options z-
direction, 3point, view and/or rotate.

2. Open the dialog window through the option command and arrange a new
user coordinate system. Now the parameters of the active coordinate
system are saved.

For the following directions it is essential that the first step has already been
taken, e.g. the coordinate system has been adjusted.



Chapter 3 Viewing Drawings

The dialog box has an option which is called user coordinate system name.
Enter the name of the new user coordinate system in this field. The name can
fill as many as 32 spaces and may contain alphabetical characters, numbers,
as wdl asthefill-in characters - (dash) and _ (underling), but no free spaces.
It is not differentiated between capital letters and small letters, all characters
will be changed to capital letters.

After entering the name click onto the field new and verify your entry. The
name of the new user coordinate system appears in the window beow the
entry- and change window. All useable coordinate systems in this drawing are
listed there.

Please remember, that all changes made in the dialog window user coordinate
system are registered only when you leave the dialog window through
clicking OK.

Renaming a user coordinate system

It may be necessary to rename user coordinate systemsin order to have a
clear name or association

1. Choose the user coordinate system to be renamed out of thelist in the
choice window by clicking onto it with the cursor. The chosen coordinate
system is accentuated through color. At the same time the name of the
chosen user coordinate system appears also in the entry- and change
window.

2. Click onto the window with the cursor or enter it by repeatedly pressing
the tabulator key, and then change the name of the user coordinate system
into its new version.

3. After that, click the fidld rename. This verifies the renaming and the new
name of the user coordinate system appears in the choice window.

Please remember that the world coordinate system cannot be renamed.
Please remember, that all changes made in the dialog window user coordinate

system are registered only when you leave the dialog window through
clicking OK.
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Erasing a user coordinate system

Erasing a user coordinate system is similar to renaming a user coordinate
system

1. Choose the user coordinate system to be deleted in the choice window by
clicking onto it with the cursor and marking it so.

2. Click onto thefield delete. The user coordinate system is then deleted, its
name no longer appears in the choice window.

Please remember, that the world coordinate system cannot be deleted.

Changing the active coordinate system

In every drawing it is possible to create as many user coordinate systems as
you wish next to the world coordinate system, but only one user coordinate
system can be the active coordinate system.

The active coordinate system is that coordinate system, whose parameters are
active (e.g. place of the origin, adjustment of the axis).

1. Choose the user coordinate system to be active in the choice window by
clicking onto it with the cursor and thus marking it. The name of the
chosen coordinate system appears at the same time in the entry- and
change window.

2. Click onto thefield active. The user coordinate system thus becomes the
active coordinate system.

3. Thefidd active user coordinate system shows the name of the active
coordinate system. Please check there, that the name of your chosen
coordinate system appears there.

Change to the previous coordinate system

To changeto a previous coordinate system there exits an option in the dialog
window user coordinate system. It enables to quickly change between two
coordinate systems. When clicking onto this field you will change to the
previous coordinate system without another entry or verification.
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Chapter 4
Layer and Object Properties

The concept of working with layers is analogous to manual drawing using
layers of see-through foil. Parts or portions (which may be functional
portions, such as construction lines) of one complete drawing are drawn on
different “foils”, which, imposed on top of one another, form the entire
drawing.

Layers are useful in separating objects, such as parts, sub-assemblies, or
structural components such as pipe sizes or building materials. They also
serve to separate elements such as construction lines, center lines, outlines,
and dimension lines, or things that are to be placed in a group, such as foliag
in an architectural drawing, or parking areas. The advantages of creating a
drawing in this fashion, whether working manually or electronically, lie in a
clearer construction of the drawing and better control than drawing on a
single foil.

This chapter describes how to create and use layers, as well as different wa
of controlling themControl refers to the visibility of the layers, their colors

and the types of lines used. In the second part of this chapter you will find
explanations on object characteristics and the various advantages of workin
with them. Objects may be parts, sub-assemblies, groups of like-attribute
entities (such as, again, parking spaces in an architectural drawing), or any
other entity that you wish to separate from other similar entities in the
drawing for particular treatment.

In the layer technigue a new object will always be placed on the current layer
At the same time the standard properties linetype and color of a layer
definition will be applied to it. Additional commands allow you to change the
object properties later on.
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Instead of working with foils as one might do manually, computer programs
for drawing construction work with layers, which have the same
characteristics as do fails . It is possible to structure a drawing through
formal or content characteristics.

L ayers are drawing layers that lie exactly on top of one ancther. All
parameters of a drawing which are active for the entire drawing, like the
coordinate system, the Zoom factor, the view arrangement, fonts, attributes,
and so forth, arevalid for al layers and are always the same.

Different layers do not necessarily follow one another in numerical order. It is

not necessarily true that layer 2 lies “on top of” layer 1 or “underneath” layer
3. All layers are arranged in one single plane, which is not possible when
drawing manually on different foils.

For elements that “hide” other elements on different layers, the rule is that the
object last drawn lies over already existing objects and hides them. The
association of one particular drawing object to one particular layer in some
particular order is not important

The standard layer is always calledyer 0. It is generated automatically by

the program when a new drawing is created. The layer color 7 (black) as well
as the linetype continuous is automatically established for this layer. This
layer cannot be erased or renamed. It is possible to creatd 0p4dayers, a
number which should be more than sufficient for any practical drawing.

Layer O has a special function when defining or inserting parts. You can find
more on that subject in the chapterRants and Attributes).

One layer in each drawing will be defined asding ent layer. All new

drawings will automatically be placed on this layer. As long as Layer O is the
only one existing, it will also be the current layer. If there is more than one
layer in a drawing, as there should be, it is possible to switch current layers
using Layer Control.
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The drawing commands work on the current layer. Y ou will always be
drawing on the current layer. However, it is possible to edit any dementsin
the drawing, even those not in the current layer, using the Edit or Modify
commands, if the layer has not been frozen, turned off or locked.

Each layer has a color and linetype associated with it when it is created.
Anything drawn on this layer will be drawn with this linetype and color. It is
also possible to associate a different color and linetype by editing the layer.

Aside from the color and the linetype, there are other attributes of the layer
that allow you switch between “states”. The states/iikility (on/off),
freeze/thaw andlock/unlock.

The layers with their status and their attributes are part of the drawing. They

are saved together with the drawing and can be called when re-opening the
drawing.
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Layer Name

To identify individual layers and differentiate between them, each must have a
distinctive name. The name can consist of up to 31 characters. They can be
letters, numbers, or special characters like _ (Underling) and $ (Dollar). All
characters are automatically capitalized.

Color

Every layer has a color that is user-defined. If a new color is not chosen, the
layer will be colored black. The standard color of the layer can be marked in
the color box asBYLAYER.

It is possible to choose the standard color of a layer from among 255 color
shades. Every color has its own number.

Sinceit is possible to draw on the current layer only, objects still to be drawn will
bein the standard color of the current layer, unless a new color was chosen with
the option Object Color. If the standard color of thelayer is changed using the
dialog box for layer control then all drawing dements of this layer that are marked
with the color BYLAY ER will assumethe new color.

Linetype

Similarly, thereis a standard linetype that is assigned to theline. If you do not
choose another linetype, the linetype CONTINUOUS will automatically be
assigned to it.

The chosen linetype is marked in the dialog box BYLAYER. All dements are
drawn in the linetype of the layer unless another linetypeis chosen for the
element.

If the linetype of alayer is changed using the dialog box layer control, all of
the drawing dements of that layer which are marked with BY LAY ER will
assume the new linetype.

The linetypes that are available are shown in a choice window. They are made
available through a linetype definition file. Please remember that only those
linetypes can be shown which have previously been loaded.
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How to Load Linetypes

The linetypes that are used to draw objects depends largely on the industry for
which the drawing is being prepared. The program, therefore, does not work
with a fixed set of linetypes, but allows you to load linetypefiles for working
in particular disciplines.

Linetype files have the extension .lin and can be found in the application
directory.

To load a linetypefile, sdect from Linetypes ..., in the menu Options, or type
the command LINETY PE.

When this command is selected, the dialog box Open Linetype File will be
opened.

Enter the name of the linetype filein theinput field Filename or choose a file
from thefilelist. In thefile format field the format .lin will appear.

Next, choose one or more linetypes from the list in the dialog box Linetype.

The preview/description area at top of the dialog box will assist you to find
an appropriate linetype.

Linetype I

(1]4 I Cancel i

After you choose and load the linetype(s), they may be associated with a layer
by using the Layer Manager, or they may be associated with already existing
drawing objects by the command PROPEDIT.
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Layer Visibility
One of the mgjor advantages of working with layersisthat it aids you in
visualizing the part, or drawing. The visual clarity of a drawing can be
improved greatly through choosing layers properly and “hiding” the drawing
elements. Concentration on meaningful drawing elements makes the drawing
and construction much easier.

Visibility of a layer can either be turned on or off. Every layer can be turned
“on” or “off” independent of any other layer(s). Changing the visibility is
done through the layer manager (command LAYER).

Locked / Unlocked Layers

It is possible to “lock” layers so that the objects or elements contained within
the layer may not be changed. Normally, new layers will be created with the
statusUNLOCKED. There are no limits inside the normal program
functions when working with an unlocked layer.

When a layer’s status iSOCKED it is not possible to change, add, or delete
objects from this layer. The status must be changeiNtoOCKED if you
desire to work with the objects of this layers. This function makes it difficult
to make an unauthorized drawing change.

It is possible to draw new elements onto locked layers but it is not possible to
work with them further. Other options of layer control can also be affected
when working with a locked layer. For example, the standard color of the
layer may be changed. A locked layer may be designated active, visible or
invisible, frozen or thawed.

Thaw / Freeze Layers

The optionsT haw and Freeze are functions which control the visibility as
well as the influence of the objects within the layer .

A frozen layer is both invisible and locked and thus impossible to change. A
frozen layer will not be included in drawing regeneration. When working with
very complex drawings, freezing some unneeded layers can increase the speed
of drawing considerably.

The optionT haw undoes the freezing of a layer. The layer will become
visible and changes may be made once more.

Note:
The current layeof a drawing cannot be frozen.
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Layer Manager

Creating new layers, choosing an current layer and controlling all previously
described layer characteristics is accomplished through a dialog box. This
dialog box is called L ayer Manager .

The control panel (side bar) contains control fields for the following layer
functions:

e Changing layers;

» Choosing a drawing color other than the one sdected in the layer
definition; and

» Choosing a linetype other than the one selected in the layer definition.

The Dialog Box used in layer control is made available by choosing the View
menu, then clicking on Layer Manager ..., or by entering the command
LAYER.

Dialog Control Elements

Thefirst section of the Layer Manager dialog box contains a field for the
name of the active (current) layer and afield for the number of defined layers
in this drawing.

Later fields contain combined view and entry fields for layers that still have to
be worked on, and a selection box that allows you to choose between creation
of new layers, renaming layers and choosing an current layer.

There are fidds for the layer state and for choosing line types and layer color.
Directly beneath that, in the Dialog Box, all the existing layers of the drawing

are shown. Any of these may be sdected and activated with the cursor. The
layer color and linetype are also shown there.
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The meanings of the abbreviations used are shown here.

Abbreviation

Meaning

On
Off
Unlk
Lock
Thw

Frz

Visibility on - The layer becomes visible

Visibility off - The layer becomes invisible

Status unlocked, drawing elements can be edited
Status locked, drawing elements can not be edited
Layer thawed, visible and can be edited

Layer frozen, invisible and can not be edited, will not
be regenerated

Creating a New Layer

A new layer can be created at any time. Newly created do not have to have
drawing ements right away.

Thelayers of adrawing are not listed alphabetically or with respect to the

content of the layer, but according to the time of the layer’s creation. To work
effectively it makes sense to plan the layers to be used in advance and create
them in a systematic manner.

A new layer is created by performing two steps:

1. Enter the name for the new layer in the entry- and view field for layer
adaptation (second row). Remember the limits of naming (see page 96).
After that, select the buttddew. The layer will appear in the list
following the layer last created.

2. Every new layer has a color 7 (black, if no other is chosen) and the
linetype (CONTINUOUS, if no other is chosen) assigned to it. Other
linetypes and colors may be assigned through selection.
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Renaming a Layer

1. Choosethe layer to be renamed from thelist of layers;

2. The name appears now in the entry window. Write the new name over the
old one;

3. Finish renaming by clicking on Rename;

4. Therenamed layer will be listed under its new namein the dialog box.

Changing the Current Layer

1. Choose the layer which you want to become the current layer from the list
in the dialog box. The name of the chosen layer will appear in the Current
L ayer window;

2. Veify the choice of the new current layer by clicking onto the button
Active.

Check the name of the current layer in the dialog box. If the layer change has
been performed correctly, the name of the chosen layer should appear there.

Define Layer Linetype

A newly created layer will automatically have the linetype CONTINUOUS
assigned to it. A new linetype can be defined with the button Linetype.

1. Click on Linetype;

2. Theavailable linetypes are shown in the window that appears. Select the
linetype to be used; and

3. Verify your choice by clicking on OK.

Thiswill make the selected linetype the standard linetype of this layer. All
drawing eements will be drawn with this linetype, which now becomes the
linetype BYLAYER.

When the linetype is changed in this manner all ements of this layer that
were drawn with the linetype that was previously standard will now be drawn
with the new standard linetype.

Elements of the layer that were drawn with a linetype different than the
BYLAYER linetype will not be affected by the change. Further instruction on
drawing dements with a linetype different than the standard linetype can be
found in the section Object Properties in this chapter.
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Define Layer Color

When a new layer is created it will automatically be assigned the layer color 7
(black). A new color can be assigned to the new layer via the click-on field

COLOR.
Colors
[ervLaver ~| rever| BvBlOck]
Cancel |
1. Click on Coalor... . The window shown above will open;

2. Choose a new standard color from among the basic colors or enter a color
number (1-255) into the entry window on the right. The chosen color will
appear in the window on the bottom;

3. Verify your choice by clicking OK.

This makes the chosen color the “standard” color of this layer. All elements of
this layer that were drawn with the standard color will be drawn with this
color, which is also called color BYLAYER.

The elements of the layer that were drawn with a color different than the
standard color will not be affected by the change.
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Controlling the Layer Status

The layer characteristics that comprise the state, or the status, of the layer
have been discussed earlier in this chapter. Changing the status of a layer is
accomplished by a clicking on the proper field. Characteristics of each layer
are displayed in this portion of the Layer Manager dialog box.

Layer Manager
— Layer
|3D_DDE|F|_‘|
Cument | Mew | Bename | Select | ﬂl
Current Layer: Used Layers:
I 18 of 4096
— Froperties
Status
Layer Mame On | Unlk| Thw
[ Alphabeticaly Sarted Off |Lack| Frz Linetype... | Calar... | -
] On  Unl Thw COMTIMUOUS Black =]
30_CEIL_PL On  Unl Thw COMTIMUOUS Black
A0 _wiall 1 On  Unl The COMTIMUOUS g
30_CEIL_1 On  Unl The COMTIMUOUS Black
30 WALl 2 On  Unl Thw COMTIMUOUS a
30_ROOFEDGE On  Unl Thw COMTIMUOUS Red
30_ROOFFACE On  Unl Thw COMTIMUOUS Fed
30_CEIL_2 On  Unl Thw COMTIMUOUS Black
30 _OPEMING 1 On  Unl  The COMTIMUOLS g
3D DOOR 1 1 dn COWTINUOWS
30_0OPEMING_2 On  Unl Thw COMTIMUOUS a b
30_DO0DR_2 On  Unl Thw COMTIMUOUS Blue
30 _WINDOW_2 On  Unl Thw COMTIMUOUS Green
30_GLAS 1 On  Unl  Thw COMTIMUOUS Black =

The layer status ON-OFF (controls the display visibility of the layer), UNLK-
LOCK (controls access to the layer, UNLK allowing editing, LOCK
prohibiting editing), and THW-FRZ (controls ability to see and to edit or
change the layer, THW unlocking and making visible, FRZ locking and
making invisible) may be changed in two steps:

1. Mark thelayer to be changed in the Dialog Box by selection with the
cursor. The status changes will be executed for the marked layer.
2. Select the fidd required for the status change(s).

Remember that the current layer cannot be frozen.
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FelixCAD contains three functions other than the Layer Manager that can be
activated through sdection. These functions are used to:

e Changethe current layer;

» Draw with a different linetype than the linetype BYLAYER,; and

e Draw with a different color than the color BYLAYER.

To call on these functions, sdect the buttons that are found on the palette on
the left-hand bar of the desktop.

Change layer

DEFPOIMTS

Solid Line Change line type
Activate

| | @ Layer Manager

Change object color

Set Current Layer

This function allows you to set a new current layer.

Note:

It is not possible to create a new layer or to change any characteristics of the
existing layer with this button. These changes must be made in the fashion
described above in the section Layer Control.

Sdlecting these buttons will open the appropriate dialog box, and the proper
sdlection can be made.

Layer I

an Unl Tha @8 -
Off Unl Tha DEFPOINTS

on Unl Tha DIH
on Unl Tha HATCH
on Unl Tha TEXT

Oon Unl Tha 1
Oon Unl Tha 2
Oon Unl Tha 3
on  Unl Tha 4 =]




Chapter 4 Layer and Object Properties

Thelettersin front of the layer names show the status of the characteristics visibility, access,
and thawing/freezing. They have the following meaning:

Abbreviation Meaning

On On (Visibility)

Off OFF (Visibility)

Unl Unlocked (Access)

Loc Locked (Access)

Tha Thawed (Thawing/Freezing)

A frozen layer cannot become the current layer, so that choice will not appear
for the current layer.

Sdlect alayer in thelist box and verify your choice by clicking on OK.

Set Current Linetype

For reasons of clarity, you may want to draw different objects with different
linetypes than the one marked BY LAYER.

Remember that a new linetype has to be chosen before drawing a new object.
To change the linetype of an object afterwards use the command PROPEDIT
(Property Edit) described later onin this chapter.

To change the current linetype, select the button Linetype... in the control
pand. The dialog box that opens is the same as that known from the Layer
Manager dialog box (see above).

1. Sdect the button Linetype in the control pand (side bar);
2. Choose alinetype from the list and verify the choice by clicking on OK.

Set Current Color

For reasons of clarity, you may want to draw different objects with different
colors than the one marked BYLAYER.

Please remember to choose the color of the object before drawing it. To
change the color after drawing the object, use the command PROPEDIT.
More specific instruction will appear on that subject later on in this chapter.

To change the color, sdect the function Color....

1. Toopenthe Set Color dialog box click on the button;
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2. Choose a new standard color from among the basic colors, or enter a color
number (1-255) in the entry window on the right. The chosen color will
appear in the view window on the bottom;

3. Veify the choice by clicking on OK.

Set Layer by Reference

The QLAYER utility provides an alternative way of layer control whichis, in
some situations, more appropriate and direct. You can s, turn off, freeze,
lock, or unlock a layer by picking a reference entity. Select the function Set
Layer by Reference from the menu Options or typein QLAY ER. Choose
one of the options from the options bar:

Off Lock Freeze Unlock On Thaw

The option Set is the standard option for QLAY ER; and is used if no other
option has been sdected.
For example, if you choose the option Set, the routine will prompt:

Sel ect reference entity to set |ayer:
The layer on which the picked entity is located will now be the current one,

The command also provides options to turn disabled layers on or to thaw
frozen layersin a dialog box. All layers with the corresponding mode are
highlighted in a list box. When you choose the OK button all marked layersin
thelist box will beturned on or frozen.

Current:
Jo Cancel

0 21— Status Control
DEFPCINTS

CLINES  Setas current
_'I'_IEA;](_JH Display: C on

1 © Off

2

3 Access:  Free

4 & Locked
]

6 Status: © Thawed
; _  Freezed
9 =l " Select All
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Modify Object Properties

These characteristics are said to be “properties” of an object:

» objects may be placed on a different layer;

» objects may have a different color;

» objects may be drawn with a different linetype; and
» objects may be drawn with a thickness (extrusion).

These characteristics are associated with a drawing automatically when it is
created. This association is made through the parameters called BYLAYER
which are determined for the layer when it is defined. Alternatively, you may
choose (in the manner just described) a special color or linetype for an objec

It may be desirable, in certain circumstances, to change these parameters ol
into the drawing or layer. In order to do this, the proper command is
PROPEDIT.

The command PROPEDIT allows you to make these changes:

» objects may be placed on a different layer;

» objects may be given a different color;

» objects may be given a different linetype; and
« the thickness of objects may be modified.

You may change any one, or all, of these properties at once.

The command to change object properties is called up by entering the
command PROPEDIT or by selecting the optibadify Object
Properties... from theEdit menu.

Mark the drawing elements whose properties are to be changed. Remember
that all marked objects will be changed. If three objects are marked, they will
all receive the same change. If different objects are to be given different
changes, each must be specified, in turn, in the same manner, and the chan
made to each separately.
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Options

When the object sdection has been completed, the following dialog box
opens. Choose the object properties that are to be changed by clicking the
proper button.

Edit Propertiez of Entities |

Layer... IEI

Linetupe. . |e~ru.wm

Calor... IBYL&YEH

T hickness: |n.nnnn

Cancel |

The characteristics color, layer and linetype each have a separate dialog box.
These dialog boxes are identical to those opened for layer linetype and color
control. Choose the desired new characteristic in each case. Thicknessis
applied directly and does not require a dialogue box.
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Modify Object Layer

The command PROPLAY ER transfers sdected objects from their current
layer to a chosen layer.

Call the command entering PROPLAY ER or by sdlecting M odify Object
Layer... from the Edit menu.

Sedlect the drawing entity to be transferred. The following dialog box appears.
Choose a target layer and confirm the selection by OK.

Modify Layer Property of Selected Entities

Target Layer:

DEFPOINTS

CLINES

Dird Cancel |
HATCH

TEXT

1

2
3
4
5
6
7
il
9
Cl

ENTERLINE
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|

The command COPY PROP allows you to change the properties of objects to
be sdlected to those attached to a specified reference entity. Only properties
that are common to all objects (layer, linetype, color) are transferred to the
selected objects.

Use this command to make changes to the properties (the line color, layer,
etc.) of sdected objects. Call the command by entering COPY PROP or select
Copy Object Properties from the Edit menu. To change the properties of the
sdlected objects:

e Sdect areference entity
» Sdect one or more objects to be changed.
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Thickness

By applying the Thickness property to drawing entities, you can create a
three-dimensional effect of certain entities. Such extrusion of entities creates
theillusion of depth.

Thickness is displayed with the following objects:

* Line

e Arc

« Circle

o 2D-Polylines
e 2DFace

The Thickness property is also displayed, if the entities listed above are
drawn with a dash-dot pattern or if these are wide polylines.

As commands like NGON, RECTANGLE, ELLIPSE, RING, or CHAIN
create 2D-polylines, Thickness setting is applied them.

Thickness can also be assigned to other drawing objects (3D-polylines, 3D-
faces, text, attributes, attribute-definitions, block insertions, dimensions,
hatchings, ...), but the program will not display the extrusion of those objects.

To set acurrent preference for subsequent drawing, set the THICKNESS
system variable. Typein the system variable name and enter a numeric value.
To turn off applying Thickness for further drawing, typein THICKNESS and
set the valueto zero.

To alter the Thickness of drawing object, use the PROPEDIT command (see
above in this chapter)
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Applying Object Selection and Object Snap on extruded entities

When sdecting entities which are displayed with extrusion thickness or when
snapping to them, keep these two rules in mind:

» Object Sdection: When you are requested to select objects, the program
will recognize picking extrusion lines as if the base entity has been
selected.

*  Object Snap: When you snap to extrusion line of entities that have a
thickness, the program will find the appropriate point of the base entity.

Treatment of extruded objectsin Rendering and Hidden Line Removal

Objects that have a thickness are recognized in the Render and Hidden Line
Removal commands (ARENDER, RENDER, HIDE, FHIDE).
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Chapter 5
Draw: Drawing Basic Entities and Objects

The commands discussed in this chapter are used to draw basic geometric
elements. These entities may be further defined, later, using the Edit and
Modify commands. Most of the following functions are available from the
menu Draw.

Line

Circle

Arc

Ngon
Rectangle
Trapezoid
Ellipse
Chain
Polyline
Pcontour
Filled Faces
Rings
Construction Points
3D-Faces
3D-Polyline

Options for each command will be shown in the context bar. The program
will usually be performed using the first option (the option of the left-most
button) as the default option.

You will be prompted for input such as the starting point of aline, length of a
line, center point of a circle, points to define an arc, and so forth. The points
or distances required can be entered either by pointing with the cursor, or by
keyboard entry as discreet coordinates or values.
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Object Snap

When defining points by pointing with the cursor, you are advised to use
object snap options in order to gain the precision provided by these functions.
If moreinformation is required about object snap, you should refer to Chapter
2, Drawing With Precision.

Linetypes

Linetype... allows to choose a linetype definition that may be used for
subsequent entity creation in the current drawing. Linetypes that were loaded
within the active drawing are available in the dialog box to set linetypes. The
linetype chosen with this option will not become the active linetype. It will
only be added to thelist of linetypes that are available.

To add a linetype to the linetype table of the current drawing, proceed in this
manner:

* inthe menu Options sdect Line Types (or enter command LINETY PE);

» thedialog box Open Linetype File will open;

 thefilefilter has already been set to be .lin. Usually linetype files are
found in the application directory.

« Thedialog box Linetype will open:

« Choose one (or more) linetypes to be loaded.

* Repeat this procedure to add other linetypes to a drawing.

Linetypes that were loaded within a drawing will be saved along with the
drawing so as to be available at a later time.

Fonts...

The Fonts... option from the Detail menu allows you to load text styles from
font files. It possible to adapt existing fonts for special drawing needs, and
use them repeatedly, with this function. There are more detained explanations
of this function in the chapter Text Objects.

Dimension Type...

The option Dimension Type... alows you to choose the type of dimensioning
to be used. More detailed explanations of this function are found in the
chapter Dimensioning.
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Drawing Modes...

| Drawi ng Modes... (command DRAWMODE) provides a set of
parameters that are helpful in the proper visibility and display control of
drawing entities. This dialog box will appear:

Yisibility and Display Modes for Drawing Entities

— Linetype

Scale Factor I-I 0o

DA
¥ Fill 5alid Entities @@
S N 5 T ]

—attibute Display Mode

D i =l 7= =
Display as defined
0 All jrvisible
" Display 4l r— Paint Size
~30 FaceEdges——————————————— " Absolute Size

&' Display a3 defined

&' Felative to Screen
" Display

—&mc Segments———————————————— Size in

Flazazrd 20
S egments (8-1024] [as el

Cancel |

=

Parameters may be activated, inactivated, or changed.

Changes in parameters will affect only the objects drawn later. If further
changes are required, they must be made again. The changes will not affect
al drawn objects until the active view has been regenerated, using the
Regener ate command on the Window menu.

Linetype Scale Factor

The Linetype Scale Factor (LTSCALE) determines a scaling factor for lines
drawn with a the linetype. The line patterns are shown extended (long dash
lines, for instance) or contracted (short dash lines, for instance) according to
this scale. To change the scale factor, enter a new number in the edit box.

Remember that, after a regeneration of the drawing, the scales of line patterns
that have been drawn already will be adjusted to the new value.
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Fill Solid Entities

TheFill Solid Entities option specifies whether or not to fill polygons.
Polygons are polylines with a width greater than zero or 2D-faces. A check
mark in the box indicates whether or not the fill function is activated.

Remember that activating the function is required in order to draw filled
planes. If the option Fill Solid Entities is deactivated, then the option Fill
Polygons will not be availablein the dialog box Print/ Plot (details in chapter
Print / Plot). The examples shown below areillustrative of the affect of filling
or not filling a plane or polygon.

___

Option Fill Solid Entities activated (left) and deactivated (right)

Attribute Display Modes
This option allows you to choose the desired display mode of attributes. The

options are:
Display as defined  All attributes are displayed according to their
definition.
All invisible All attributes are made invisible, e.g. their

status is defined as invisible.

Display all All attributes are displayed, independently of
how they were defined.

Choose a display option by clicking its field.

3D-Edge Visibility Mode

If, in the display of 3D views, intersections or lines that are “behind” other
drawing segments are to be hidden, you should select the Dimayed as
defined. If, on the other hand, all intersections are to be displayed, then the
selection should bBisplay all.
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Arc Segmentation

Arcs and circles are displayed on the screen as a series of short straight-line
segments.

In this edit box specify the number of segments that any arc or circlethat is

drawn will appear. The number sdected may be any whole number between 8

and 1024. A smaller numbeiillwnake the arcs or circles appear “jagged”; a
larger number will tend to smooth them out. The default number used is 48.

Note, that a large number of line segments in an arc or circle will tend to a
slow the performance, whereas a small number of segments will increase
working speed. Some Printers / Plotters are affected by this number for theil
output quality.

Display of a circle with 48 (left) and 18 (right) straight line segments

Point Representation

This area of the dialog box allows you to choose between 20 different display
forms for construction points. The point mode will be actualized when the
drawing is regenerated.

Point Size

This area of the dialog box allows you to choose the size point entities. This
parameter defaults tabsolute, and uses 3 drawing units to display
construction points.

Absolute Size The size of points is determined in the absolute
scale of drawing units.

Relative to The display of points is determined relative to

Screen the size of the visible drawing plane.

117



Chapter 5 Draw

Line

|4| The command LINE is used to draw lines or line segments. Inputs to the
command are two points; the starting point and the ending point of theline.
The command will immediately display in the option bar four choices:

Continuous | Segments Append TT

Continuous
Continuous is the standard option when drawing lines, will automatically be
used when no other option is chosen. It allows you to draw line segmentsin
sequence until the command is terminated.

The command will request a start-point for the line, and will continue to
request points until it is terminated. Each subsequent point will be connected
to the previous point by aline.

P1
P2

P3 P4

From Poi nt: P1

(points are defined by the coordinate system chosen, with thefirst coordinate the X
coordinate, then the Y coordinate The coordinates are separated by a comma, thus:)
To Point: 2.5,2.5

(+ 2.5 unitsin the X direction, and 2.5 unitsin the Y direction).

To Point: P2

To Point: P3

To Point: P4

When continuous line mode is chosen, the options Undo and Close are
availablein the option bar.
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The option Undo can be used repeatedly to erase the last drawn line segment.

The option Close connects the last drawn point with the start point of in the
Line Continuous command.

To terminate the command, press ENTER or ESC.

Segments

The option Segments allows the creation of single line segments, as opposed
to continuous lines.

As with continuous lines, determine the start- and end-point of the first
segment. The program will then continue to ask for start- and end-points. The
differenceis that the lines drawn usually have individual start points and are
not appended to end point of the previous line segments. To end the drawing
of line segments, press ENTER or ESC.

P1 P2

P3 P4

From Point: P1

To Point: P2

From Poi nt: P3

To Point: P4

From Poi nt: <hit Enter key>
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Append

The option Append allows the connection of alineto either the start or end
point of another line or arc. Choose theline or arc that is to be connected to
theline still to be drawn.

Line to Line

Select an dement by choosing an already existing line or arc. Remember that
the new line will be connected to that point of the line or arc that lies closest
to the chosen point.

When appending alineto aline, sdect the line to which the appended line will
connect. The point (start or end) of that line closest to the sdected point on
theline will be the start point for the new line.

Line to Arc

To append alineto an arc, sdect the arc to which thelineis to be appended.
The prompt will ask for the length of theline. Either keyboard the length, or
pick the length with the cursor. For precision, it is better to keyboard the
length. The appended line will be connected to the end point of thearc as a
tangent.

connecting point end point of line

Select line or arc: P1
To point: P2
To point: <hit Enter key>

The following options will be available in the context bar:

Undo Close

The options Undo and Close are available at the context bar when drawing a
line, chain, 2D or 3D polyline.
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TT

Undo

The option Undo allows you to undo the last step taken. The end point of the
last line segment may then used as a starting point of another segment if
required. Undo’s can be repeated as long as a segment exists. The last
segment will be erased with each successive Undo.

The option Undo allows you to undo the last step taken. In other words, the
last-drawn segment will be erased. The end point of the previous segment is

then used as a starting point of the next segment. Undo’s can be repeated a
long as a single segment exists.

Close

This option allows you to draw a closed line contours or closed polygons.
Choose the optio@lose from the context bar or enter the option manually.
The two end points of the line contour will then be connected to each other.

The optionUndo allows you to undo (erase) the last drawn segment.

The optionClose allows you to create closed 3D polylines. The option will
cause the two remaining end points to be joined together and terminates the
command.

The end point of the last remaining segment will act as the starting point for
the next segment. Théndo function can be repeated as many times as
necessary until the Undo List is empty.

Tangent Tangent option. Allows you to draw a line tangent to two arcs or
circles. Useful in creating compound or reverse curves with a line segment in
between the arcs. You will be presented with 2 prompts as follows;

Tangent from:

Tangent to:

After picking the two arcs or circles the line command will continue as noted
above.
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Circle
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g There are several ways, geometrically, to describe a circle. The
program allows you to choose from among these ways, and draw the circlein
the most convenient manner. A circle can be drawn by choosing of one of the
following options:

e Center of thecircle and radius or diameter;
* Two Points on the circumference; or

* Three Points on the circumference.

* Two Tangents

Thefollowing options will appear on the option bar when calling the
command CIRCLE:

Center 3P 2P Radius Diameter Tangent

Center (Center Point)

Since this option is the most often chosen, it has been selected as the

“standard” option and is activated automatically if no other option is chosen.
The first prompt for this option will be the location of the center point; the
second will ask for the radius. If the circle being drawn is preceded by another
circle, the last radius will appear at the prompt as an option. To verify the
default radius value, just press ENTER; to change the option, enter or point a
new radius.

If it is more convenient to enter the diameter than the radius, you may choose
that option from the context bar.
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3P (Three Points on the Circumference)

This option allows you to draw a circle by choosing three points on the
circumference of the circle. It is convenient to use when the circle must
intersect three tangent lines, or when drawing the circle within a polygon.

The prompt will ask for three points successively. You may point to these
points on the screen, perhaps using the object snap options, or enter the
coordinates through the keyboard.

2P (Two Points on the Circumference)

The prompt will ask for two points in succession. Again, the points may be
picked using the object snap functions, or may be entered from the keyboard.
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Radius

This geometry is particularly useful when the radius of the circleis a known,
and the center point is undefined, or when the radius follows from geometry
already established.

This function starts drawing the circle from the center. The circleis defined
by a value for the radius and the determination of a center point.

These options are for entering the radius:

* Veify thelast entered radius by ENTER,;

» Enter anew valuefor the radius manually; or

» Pick two points for the radius in the drawing. Thisis especially useful
when the radius follows from an existing geometry.

After entering the radius, the center point of the circle has to be identified.

Diameter

The use and the implementation of the Diameter option follows exactly the
use and implementation of the option Radius except that instead of choosing
the radius of the circle, you must specify the diameter.

124



Chapter 5 Draw

Tangent

This option, frequently used, will draw a circle of given radius or diameter
tangent to two lines.

Thefirst prompt will ask for the tangent elements. First, select these entities.
After choosing the second object, enter the radius of the circle to be drawn.
Theradius of the last circle drawn is displayed as the default value by the
program. Verify this choice with ENTER or choose a new value manually or
by pointing it on the screen.

Thecirclewill be placed so that it touches, tangentially, the two chosen
entities.

P2

P1

If the chosen radius is smaller than the distance of the two objects to each
other, the circle will be moved in the direction of theimaginary point of
intersection, so that the defined radius will touch the extension of the
elements.

If the specified radius for a tangential construction is not valid, the program
gives the message: Circle does not exist!
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ﬂ There are several ways, geometrically, to describe an arc, just aswith a
circle. The program allows you to choose from among these methods, and
draw the arc in the most convenient manner.

Thefollowing options for drawing an arc are available:

» Three Points (starting point, second point, end point);
» Two points and radius;

» Two points and angle of opening;

» Two points and center point;

« Two points and tangents through starting point;

e Center point, starting point and angle; or,

» Center point and two angles.

Variations of the options of this command may combine some of the basic
geometry inherent to each method.

Note:
All arcs will be measured to the left, starting from the positive x-axis.

It is important to recognize this directional convention. To pick points for the
construction of arcs, you should use the object snap options.

The options are displayed in the option bar when the command is active:

3Point SEnd SCenter CStart Cradius Append

3Point

Since the method most used for drawing arcs is to seect three points on the
arc, that is the option chosen as the “standard”, or default, option. It will be
used if no other option is chosen.

The arc to be drawn is defined by three points. At the prompt, enter the
starting point, a second point on the arc’s circumference and the end point of
the arc.
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Remember the directional convention; the arc is described to the lft starting
with the positive X-axis.

start

2. point

Start point: Pl
Second point: P2
End point: P3

Starting Point - End Point - Radius/Angle

Using the option SEnd, you may create arcs with only the starting point and
end point defined. The arc is defined by specifying a radius or an angle.

The basic variation of this option simply follows the prompts, entering the
starting point and end point and the radius of the arc by picking or by entering
through the keyboard.

starting point starting point

closed-in angle

|
|
end point i end point

Starting point: Pl
End point: P2
Radi us: Val ue

It is also possible to enter a radius, an angle or a direction from the starting
point instead of the starting point and the end point. To do that, choose the
option Angle or Sartpoint.
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Angle

With this option the arc is defined by the included angle of the arc (angle
between the starting point, the center point of the arc and its end point), the
starting point, and the end point. The prompts will request a value with the
words Included angle:

Enter that value either through the keyboard, or by picking a value. When
picking a value, remember that the x-axis is the point of reference, not the last
point entered.

Direction

The arc is defined by a tangent which touches the arc at its starting point,
next to its starting point